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R&S®SMM-K40/-K41 Welcome to the GSM/EDGE and EDGE evolution digital standard

1 Welcome to the GSM/EDGE and EDGE
evolution digital standard

The R&S SMM-K40 is a firmware application that adds functionality to generate signals
in accordance with the GSM/EDGE standard, based on the GMSK and 8PSK modula-
tion. Option R&S SMM-K41 EDGE Evolution extends the GSM/EDGE signal genera-
tion with simulation of higher order modulations (QPSK, 16QAM and 32QAM) for
higher symbol rate bursts and higher order modulations (16QAM and 32QAM) for nor-
mal symbol rate bursts.

The R&S SMM-K40 features:

® Generation of all GSM variants. There is no restriction regarding the use of GSM
slots, EDGE slots and EDGE Evolution slots.

® (Generation of both the transmitter signal of a base station (BS) and the transmitter
signal of user equipment (UE).

® Configuration of all kind of GSM/EDGE data bursts Normal (full rate and half rate)
and EDGE; control bursts Access, Frequency Correction and Synchronization; a
Dummy Burst; and bursts for test purposes, All_Data (GSM and EDGE).

® Generation of half rate slots and multi slots for HSCSD (high speed circuit switched
data) and (E)GPRS (general packet radio service) configurations at the physical
level.
Allocation of multiple slots to a single connection (channel banding).

® Three configuration modes for each the normal and the higher symbol rate mode:
unframed, frame (single) and frame (double)
The R&S SMM-K41 features:

® Generation of burst types defined for normal symbol rate and higher order modula-
tion schemes such as the data burst Normal (16QAM and 32QAM) and All_Data
(16QAM and 32QAM) as well as with the burst types defined for higher symbol
rates HSR (QPSK, 16QAM and 32QAM) and HSR All_Data (QPSK, 16QAM and
32QAM).

® Configuration and generation of burst for VAMOS operation. Available are All_Data
(AQPSK) and Normal (AQPSK) bursts for full and half rate operation.

For more information, see data sheet.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMM100A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMM100A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMM100A service manual.

User Manual 1179.2048.02 — 05 5


https://www.rohde-schwarz.com/manual/smm100a

R&S®SMM-K40/-K41 Welcome to the GSM/EDGE and EDGE evolution digital standard

Documentation overview

1.1 Accessing the GSM/EDGE dialog

To open the dialog with GSM/EDGE settings
» In the block diagram of the R&S SMM100A, select "Baseband > GSM/EDGE".
A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.2 What's new

This manual describes firmware version FW 5.30.047.xx and later of the
R&S®SMM100A.
Compared to the previous version, it provides the new features listed below:

® Time-based triggering, see "Time Based Trigger" on page 19 and "Trigger Time"
on page 20.

® [Editorial changes

1.3 Documentation overview

This section provides an overview of the R&S SMM100A user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smm100a

1.3.1 Getting started manual

Introduces the R&S SMM100A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.3.2 User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:

® Base unit manual
Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.
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Documentation overview

® Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMM100A is not included.

The contents of the user manuals are available as help in the R&S SMM100A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.3.3 Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.3.4 Instrument security procedures

Deals with security issues when working with the R&S SMM100A in secure areas. It is
available for download on the internet.

1.3.5 Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.3.6 Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMM100A. It also lists
the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smm100a
1.3.7 Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.
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1.3.8

1.3.9

1.4

Scope

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smm100a

Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smm100a

Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

HOME VIDEOS SHORTS PLAYLISTS COMMUNITY CHANNELS ABOUT 'Q <product=

Figure 1-1: Product search on YouTube

Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.

In particular, it includes:

® Managing settings and data lists, like saving and loading settings, creating and
accessing data lists, or accessing files in a particular directory.

® Information on regular trigger, marker and clock signals and filter settings, if appro-
priate.

® General instrument configuration, such as checking the system configuration, con-
figuring networks and remote operation

® Using the common status registers

For a description of such tasks, see the R&S SMM100A user manual.
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Notes on screenshots

1.5 Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

User Manual 1179.2048.02 — 05 9



R&S®SMM-K40/-K41 About the GSM/EDGE options

GSM/EDGE

2 About the GSM/EDGE options

2.1

2.2

Required options

The basic equipment layout for generating GSM/EDGE signals includes the options:
® Baseband Generator(R&S SMM-B9)

® Baseband real-time extension (R&S SMM-K520)

® Option GSM/EDGE (R&S SMM-K40)

® Option EDGE evolution (R&S SMM-K41)

® Frequency option (e.g. R&S SMM-B1006)

You can generate signals via play-back of waveform files at the signal generator. To
create the waveform file using R&S WinlQSIM2, you do not need a specific option.
To play back the waveform file at the signal generator, you have two options:

® |nstall the R&S WinlQSIM2 option of the digital standard, e.g. R&S SMM-K255 for
playing LTE waveforms

® |f supported, install the real-time option of the digital standard, e.g. R&S SMM-K55
for playing LTE waveforms

For more information, see data sheet.

GSM/EDGE

GSM is a TDMA standard for cellular mobile radio networks.

Every TDMA frame consists of eight timeslots (or simply "slots"). Each slot can be sep-
arately turned on or off. A maximum of seven different level attenuation values can be
defined and allocated separately to the eight slots independently of one another.

To configure a slot, it is necessary to define a burst type. Different burst types are avail-
able, depending on the installed options. Available are burst types defined for normal
symbol rate and higher-order modulation schemes and with the burst types defined for
higher symbol rates HSR.

Higher symbol rates are achieved by reduction of the symbol period and employing of
higher symbol rate bursts (HB) instead of the normal burst (NB). A normal burst con-
tains 116 encrypted symbols and uses timeslots with normal duration (156 or 157 sym-
bols long). The higher symbol rate bursts carry information on full rate packet traffic
channels, contain 138 encrypted symbols and use timeslots with reduced symbol dura-
tion (187 or 188 symbols long).

The modulation data is continuously inserted into the chosen slots. In this fashion, the
data generator uses a digital signal processor to generate a data stream complete with
modulation data and control signals for power ramping.

This data stream is converted into 1/Q signals in the modulation encoder.
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VAMOS (voice services over adaptive multi-user channels on one slot)

The R&S SMM100A processes the signal depending on the configured modulation
scheme and selected symbol rate mode:

® |n accordance with the GSM standard, the MSK modulation type is set by default to
a symbol rate of 270.833 ksymb/s and gauss filtering.
You can adjust the symbol rate. Also, you can use an FSK modulation with configu-
rable span.

® |n accordance with the standard, the EDGE slots use 8PSK modulation type with
3/8 rotation at a symbol rate of 270.833 ksymb/s and gauss linearized filtering.

® |n accordance to EDGE evolution specifications (option R&S SMM-K41), the EDGE
evolution slots in a normal burst (NB) are 16QAM or 32QAM modulated. They use
a symbol rate of 270.833 ksymb/s and are gauss linearized filtered. The EDGE
evolution slots in higher symbol rate bursts (HB) are QPSK, 16QAM or 32QAM
modulated. They use a symbol rate of 325 ksymb/s and are spectrally narrow or
wide pulse shape filtered.

® |n accordance to VAMOS specifications (option R&S SMM-K41), the slots are
AQPSK modulated at a symbol rate of 270.833 ksymb/s and gauss linearized filter-

ing.
You can configure the GSM/EDGE signal in on of the following modes:

® Mode unframed - a signal with standard-compliant modulation parameters but
without slot and frame structure is generated.

® Mode frame (single) - a signal consisting of a frame is generated; it is also possi-
ble to choose half rate bursts and to define multi-slots.

® Mode frame (double) - a signal consisting of two frames is generated; the frames
are repeated according to a defined default.

2.3 VAMOS (voice services over adaptive multi-user
channels on one slot)

According to 3GPP TS 45.001, with VAMOS it is possible to serve two MS simultane-
ously on the same physical resource. Thus the voice channel capacity in the CS
domain can be doubled.

Each of the two VAMOS users is assigned a so-called VAMOS subchannel, i.e. the
physical radio resource is split into two subchannels, one for each VAMOS user. The
two subchannels are separated in uplink and downlink via training sequences. For this
purpose, 3GPP TS 45.002 defines two sets of training sequence codes (TSC). One
VAMOS user/subchannel gets a training sequence from TSC set 1, the other from TSC
set 2. This ensures that the two training sequences have a low cross-correlation. All
mobiles must support TSC set 1, but only mobiles explicitly indicating support for
VAMOS must also support TSC set 2.

In the uplink, two GMSK modulated signals interfere with each other and the base sta-
tion receiver requires an advanced multi-user detection algorithm.

In the downlink, a novel modulation scheme is used for each subchannel. The two sub-
channels are combined orthogonally by mapping them to the | and Q axis. This results
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VAMOS (voice services over adaptive multi-user channels on one slot)

in a QPSK modulation scheme, where each constellation point has a subchannel 1
component and a subchannel 2 component, as shown in the following figure.

2, Subchannel 2

|, Subchannel 1

Figure 2-1: QPSK modulation, sum of both subchannels

In this figure, both subchannels use the same power level. VAMOS allows subchannel-
specific power control, so that the two subchannels can use different power levels, e.g.
when the two users are located at different distances from the base station. The result-
ing modulation scheme is called adaptive QPSK (AQPSK). The following figure shows
an example where subchannel 2 mapped to the Q-axis uses a higher power level than
subchannel 1 mapped to the l-axis.

Q, Subchannel 2

(0.0)

|
I, Subchannel 1

(1.1

Figure 2-2: AQPSK modulation, subchannel 2 with higher power level
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VAMOS (voice services over adaptive multi-user channels on one slot)

The power level of subchannel 2 relative to the power level of subchannel 1 is called
subchannel power imbalance ratio (SCPIR). It is related to the angle a as follows:

SCPIR = 20 * log,(tan a) dB
Where the value of a is chosen such that [SCPIR|<10dB
For a = 45° the SCPIR equals 0 dB and the two power levels are equal.

AQPSK modulation is applied in the downlink if speech frames have to be transmitted
on both subchannels simultaneously.

In this implementation, you can set the SCPIR and configure the VAMOS subchannels,
TSC set and TSC used. The available VAMOS settings depend on the mode the signal
is generated in:

® "Unframed"
Two data sources are provided, one per each VAMOS subchannel; the data is
AQPSK modulated but only one SCPIR can be configured.

® "Framed (Single)"
Full rate, half rate and combination of both slot types are supported. The character-
istics of each of the half rate slots can be adjusted individually
Separate data source is provided per each VAMOS subchannel and each user in
half rate mode; the data is AQPSK modulated and eight SCPIRs can be configured
Training sequence (TSC) set and TSC used can be configured on a VAMOS sub-
channel/User basis

® "Framed (Double)"
The settings of each of the two frames are as in the "Framed (Single)" mode.
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General settings

3 GSM/EDGE configuration and settings

3.1

Access:

» Select "Baseband" > "GSM/EDGE".

The remote commands required to define these settings are described in Chapter 4,
"Remote-control commands", on page 62.

General settings

This tab provides access to the default and the "Save/Recall" settings. The selected
sequence mode determines the available parameters.

—_ X
Trigger In Clock : - :
Set To i Generate
I o Default | @Recall | Save 9 Waveform

Sequence Mode
Framed (Single)

Symbol Rate Mode

@Modulalion/Filter/ARB

ePower Ramp/Slot Attenuations ..

Normal Symbol Ratev

Cosine / 2.0 sym

Settings

] = (= T 14
ST SY A (o T 1= =TV R 15
SAVE/RECAIL....c.ceeeeeeieteeee et e e e e e e e e e e e e e e —————— 16
Generate Waveform File. ..o 16
7= Yo (01T a Lot 1Y, (oo [ TS 16
SYMDOI RAtE MOE....cccoiiiiie e 16
SIMUIAION MOGE.......eee ettt e e e e e e e s e e e e e e e eeaaseeeeees 16
1Y o Yo (8] F= 1 ToT VA 1 (T AN o = N 17
Power Ramp/Slot AENUALIONS........coiiiiiii e 17
State

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command:
[ :SOURce<hw>] :BB:GSM: STATe on page 69
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R&S®SMM-K40/-K41

Set to Default

GSM/EDGE configuration and settings

General settings

Calls the default settings. The values of the main parameters are listed in the following

table.

Parameter Value

State Not affected by "Set to Default"
Mode Framed (single)

Modulation

Symbol Rate Mode

Normal Symbol Rate

Symbol Rate 270.833 ksymb/s
Ignore 1/4... Off
Force Dummy Bits to 1 Off

Mod. Type GSM

MSK 1bit/sym

Filter Gauss
Filter Par. BT 0.3
Power Ramp Control

Ramp Time 2 sym
Function Cosine
Slot Attenuation 1...7 0dB

Slot 0 Configuration

other settings as slot 0

Burst Type Normal (full rate)
Slot Level Full

Multislot Off

Number of Slots 1

Data PRBS 9

Use Stealing Flag On

Stealing Flag 0

TSC Set1,TSCO
Slot 1 to 7 Configuration

Slot Level, Off

Remote command:

[ :SOURce<hw>] :BB:GSM: PRESet on page 65
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General settings

Save/Recall

Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.

The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.

See also, chapter "File and Data Management" in the R&S SMM100A user manual.

Remote command:

[ :SOURce<hw>] :BB:GSM: SETTing:CATalog? on page 66
[ :SOURce<hw>] :BB:GSM:SETTing:LOAD on page 67

[ : SOURce<hw>] :BB:GSM: SETTing: STORe on page 67

[ :SOURce<hw>] :BB:GSM: SETTing:DELete on page 66

Generate Waveform File...

With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension * . wv. You
can define the filename and the directory, in that you want to save the file.

Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.

Remote command:
[ : SOURce<hw>] :BB:GSM:WAVeform:CREate on page 69

Sequence Mode
Selects GSM/EDGE mode.

There are three modes available:
® Unframed
See Chapter 3.6, "Mode unframed", on page 25
® Framed (single)
See Chapter 3.7, "Mode framed (single)", on page 27
® Framed (double)
See Chapter 3.8, "Mode framed (double)", on page 29

Remote command:
[ : SOURce<hw>] :BB:GSM: MODE on page 65

Symbol Rate Mode
(with option R&S SMM-K41 EDGE Evolution)

Set the symbol rate mode, i.e. determines whether a normal burst (NB) or higher sym-
bol rate bursts (HB) is generated.

Remote command:
[ :SOURce<hw>] :BB:GSM: SRATe : MODE on page 68

Simulation Mode
Selects the modulation for the signal for the "Unframed" "Sequence Mode"

The signal is generated without slot or frame structure.
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Trigger settings

The available simulation modes depend on the selected symbol rate:

® Normal Symbol Rate - GSM (MSK or FSK), AQPSK, 8PSK/EDGE, 16QAM and
32QAM

® Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.

For GSM, the modulation to be used (MSK or FSK) is set by means of the parameter

"Modulation" in the "Modulation/Filter" menu.

Note: "Higher Symbol Rate Mode" and "Simulation Modes" AQPSK, 16QAM, 32QAM,
HSR QPSK, HSR 16QAM and HSR 32QAM require option R&S SMM-K41 EDGE Evo-
lution

Remote command:
[ :SOURce<hw>] :BB:GSM: SMODe on page 67

Modulation/Filter/ARB
Accesses the "Modulation/Filter/ARB" dialog, see Chapter 3.10, "Modulation/filter",
on page 32.

Remote command:
n.a.

Power Ramp/Slot Attenuations
Requires "Sequence Mode > Framed (Single)/Framed Double".

Accesses the "Power Ramp / Slot Attenuations" dialog, see Chapter 3.11, "Power
ramping/slot attenuation”, on page 41. The dialog is used to set the power ramping
parameters and for setting values for the level attenuation in dB.

The currently selected ramp function and ramp time are displayed.

Remote command:
n.a.

3.2 Trigger settings

Access:

» Select "GSM/EDGE" > "Trigger In".

—_ X
|8 General [EX Trigger In Py P L S [ (Single) Configuration
Retrig Internal 9 9

Mode

Retrigger'

@Execule Trigger |

Source

-
Internal

This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
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Trigger settings

The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chapter 3.5,
"Local and global connectors settings", on page 25.
You can map trigger signals to one or more User x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:

1/ Yo [P 18
Signal DUration UNit........ooeeeeeee et 19
ST o= I TN =1 1T o T PP 19
RUNNING/STOPPEA. ...ttt e e e e e e e s s r e e e e e e e e e e e e e snnnenreens 19
L= = 7= TST=Yo I I 4 o o 1= SRR 19
B (o T = T2 = TSP 20
N 2 OSSR 20
EXECULE TrIgOBN e eiieie ettt e e e e e e s s e e e e e e e e e e e e s 20
T 10 oSSR 20
Sync. Output to External Trigger/Sync. Output to Trigger........cccccvvivieeeeeeeeeeeicccieeeen, 20
External Inhibit/Trigger INNiDit............ooiiiiiii e 21
External Delay/Trigger DEIAY ... e 22
Mode

Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-

tion.

e "Auto"

The signal is generated continuously.

® "Retrigger"
The signal is generated continuously. A trigger event (internal or external) causes a
restart.

® "Armed Auto"
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Trigger settings

The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

® "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

® "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command:
[ : SOURce<hw>] :BB:GSM[ : TRIGger] : SEQuence on page 82

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command:
[ :SOURce<hw>] :BB:GSM:TRIGger : SLUN1t on page 84

Signal Duration
Requires trigger "Mode" > "Single".

Enters the length of the trigger signal sequence.

Use this parameter, for example, for the following applications:
® To output the trigger signal partly.
® To output a predefined sequence of the trigger signal.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger : SLENgth on page 84

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.

® "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

e "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger : RMODe? on page 83

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".

Activates time-based triggering with a fixed time reference.

The R&S SMM100A triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As trigger source, you
can use an internal trigger or an external global trigger.
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Trigger settings

How to: Chapter "Time-based triggering” in the R&S SMM100A user manual.

Remote command:
[ : SOURce<hw>] :BB:GSM: TRIGger: TIME [ : STATe] on page 86

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".

Sets date and time for a time-based trigger signal.

Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMM100A. If you set an earlier trigger time than the current
time, time-based triggering is not possible.

How to: Chapter "Time-based triggering" in the R&S SMM100A user manual.
"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.

Remote command:
[ : SOURce<hw>] :BB:GSM: TRIGger : TIME : DATE on page 85

"Time" Sets the time of the time-based trigger in format hh:mm:ss.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger : TIME: TIME on page 86

Arm
Stops the signal generation until subsequent trigger event occurs.

Remote command:
[ :SOURce<hw>] :BB:GSM:TRIGger : ARM: EXECute on page 83

Execute Trigger
For internal trigger source, executes trigger manually.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger :EXECute on page 83

Source

The following sources of the trigger signal are available:

® "Internal"
The trigger event is executed manually by the "Execute Trigger".

e "External Global Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the User x connectors.

® "Baseband Sync In"
In primary-secondary instrument mode, secondary instruments are triggered by the
active edge of the synchronization signal.

How to: "Routing and activating a trigger signal" on page 18

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger : SOURce on page 84

Sync. Output to External Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.

Y llonll
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Trigger settings

Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

| Ext

| Trigger Event

\

Calculated
signal

| \_/

Signal at

the output
»—]<&-Processing time—

o "Off

The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

| Ext

| Trigger Event

\

Calculated
signal

Il

| \_/

| Signal at
the output

»—]<&-Processing time—

Remote command:
[ :SOURce<hw>] :BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut
on page 83

External Inhibit/Trigger Inhibit
Applies for external trigger signal.

Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.

For more information, see chapter "Basics" in the R&S SMM100A user manual.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger [:EXTernal] : INHibit on page 85
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Marker settings

External Delay/Trigger Delay
Delays the trigger event of the signal from:
® The external trigger source

Use this setting to:
® Synchronize the instrument with the device under test (DUT) or other external devi-
ces

For more information, see chapter "Basics on ..." in the R&S SMM100A user manual.

Remote command:
[ :SOURce<hw>] :BB:GSM: TRIGger [ :EXTernal] : DELay on page 85

3.3 Marker settings

Access:

» Select "GSM/EDGE" > "Marker".

GSM/EDGEA

_
etrig Internal

Mode Period
Frame 1 Frames

Delay

0.000 sym

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.

Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 3.5, "Local and
global connectors settings", on page 25.
You can map marker signals to one or more User x or T/M connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A adds the marker signal to the baseband signal. Also,
R&S SMM100A outputs this signal at the configured User x connector.
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Marker settings

About marker output signals
This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:

1Yo o [N 23
== TP PP PPPRPPP 24
Mode

Marker configuration for up to 3 markers. The settings are used to select the marker
mode defining the shape and periodicity of the markers. The contents of the dialog
change with the selected marker mode.

How to: "Routing and activating a marker signal" on page 22

"As defined in Slots"
The marker defined for each slot separately in the burst editor is
used. The name of the marker is displayed to the right of the selec-
tion. Definition of the slot marker is described in Chapter 3.13, "Slot
marker definition", on page 57.

"Slot" A slot clock with the slot period specified under Period is generated
on the output connector. The marker signal is generated after every
specified number of slots.

It is important to be aware of the variation in the GSM/EDGE slot
length 156 to 157 symbols. At a slot length of 156 symbols, a period
of 1 symbol and a symbol rate of 270.833 ksymb/s the clock is
0.577 ms. At 157 symbols, it is 0.580 ms

"Restart" A marker signal is generated at the start of each ARB sequence.

"Frame" A frame clock with the frame period specified under "Period" is gener-
ated on the output connector. The marker signal is generated after
every specified number of frames.

A GSM/EDGE frame has 1250 symbols. At a symbol rate of 270.833
ksymb/s and a period of 1, the clock is 4.615 ms.

"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.
The maximum pulse frequency is half the symbol rate.

Remote command:

[ : SOURce<hw>] :BB:GSM: TRIGger :OUTPut<ch>:PULSe:
DIVider on page 88

[ :SOURce<hw>] :BB:GSM: TRIGger :0UTPut<ch>:PULSe[:
FREQuency] ? on page 89
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"Pattern”

"On/Off Ratio"

GSM/EDGE configuration and settings

Clock settings

A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 64 bits and is defined in an input field
which opens when pattern is selected.

Remote command:

[ :SOURce<hw>] :BB:GSM:TRIGger:OUTPut<ch>:PATTern

on page 88

A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.

On time Off time On time Off time

Remote command:

[ :SOURce<hw>] :BB:GSM: TRIGger :OUTPut<ch>:0ONTime
on page 87

[ : SOURce<hw>] :BB:GSM:TRIGger :OUTPut<ch>:0FFTime
on page 87

Remote command:

[ : SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:MODE on page 87

Delay
Delays the marker signal at the marker output relative to the signal generation start.

Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command:

[ : SOURce<hw>] :BB:GSM: TRIGger : OUTPut<ch>:DELay on page 89

Access:

Clock settings

» Select "GSM/EDGE" > "Clock".

Trigger In Clock . .
=l Framed [Smgle} Conﬁguratlon

Clock Source

-
Internal

This tab provides settings to select and configure the clock signal, like the clock
source and clock mode.

Defining the clock
1. Select "Clock" > "Source" to define the source of clock signal.

2. For external clock signals, define the connector for signal input. See Chapter 3.5,

"Local and global connectors settings", on page 25.
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3.5

3.6

Mode unframed

You can map clock signals to one or more User x or T/M connectors.
Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMM100A starts baseband signal generation with a symbol rate that
equals the clock rate.

About clock signals
This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMM100A user manual.

Settings:
(0110 Te] 1S o1U [ ot T 25

Clock Source
Selects the clock source.
® "Internal"
The instrument uses its internal clock reference.

How to: "Defining the clock" on page 24

Remote command:
[ :SOURce<hw>] :BB:GSM:CLOCk: SOURce on page 81

Local and global connectors settings

Accesses a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:

® "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block
diagram.

® "Trigger In", "Marker" and "Clock" tabs that are accessible via the "Baseband"
block in the block diagram.

@Local Connectors ...

See also chapter "Local and global connectors settings" in the user manual.

Mode unframed

1. To access this dialog select "General > Sequence Mode > Unframed".
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Mode unframed

2. Select "Unframed Configuration".

— X

Trigger In Clock .
m U"framEd cunﬁgurauun

Data

Data i @Select Data List ...
Data List None

This dialog displays the signal in "Unframed" mode - no frames, no power ramping.

In "Unframed" mode, a modulation signal without slot or frame structure is generated.
The modulated carrier without power ramping is often enough for initial tests, and in
case the complete signal is not yet needed.

Since all the modulation parameters for the signal are conform to the standard, only
the symbol rate mode and the modulation have to be selected. The symbol rate and
filter configuration are set accordingly.

This mode can be used for quick measurements of the spectrum or signal quality (e.g.
EVM).

Data

Selects data source.

The following standard data sources are available:

e "AllO, All 1"

An internally generated sequence containing 0 data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
e ‘"Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern” box to define the bit pattern.
® "Data List/Select DList"

A binary data from a data list, internally or externally generated.

Select "Select DList" to access the standard "Select List" dialog.

— Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to
select an existing data list.

— Use the "New" and "Edit" functions to create internally new data list or to edit
an existing one.

— Use the standard "File Manager" function to transfer external data lists to the
instrument.
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Mode framed (single)

See also:

® Section "Modulation Data" in the R&S SMM100A user manual.

® Section "File and Data Management" in the R&S SMM100A user manual.
® Section "Data List Editor" in the R&S SMM100A user manual

Remote command:

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ :SOURce] : DATA on page 95

[ :SOURce<hw>] :BB:GSM][ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ : SOURce] : DATA: PATTern on page 97

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ : SOURce] : DATA:DLISt on page 96

3.7 Mode framed (single)

1. To access this dialog select "General > Sequence Mode > Framed (Single)".

2. Select "Framed (Single) Configuration".

— X

Trigger In Clock - -
m Framed (SmgIE) cnnﬁguratlnn

Frame: Select Slot To Configure

Frame
Norm %, , m Norm Norm Norm
GMSK Norm GMSK GMSK AQPSK

Norm

0 1 2 3 4 ‘ 5 | 6 ‘ 7
Save,’RecaII Frame ... |

This dialog displays the frame structure and provides access to the dialog for sav-
ing and loading a frame structure.

The "Framed (single)" mode generates a modulation signal which is defined by the
structure of a single frame. The frame structure is repeated cyclically, but the useful
data is continuously generated.

The frame structure is displayed in graphical form. Slot parameters can be defined in
the burst editor, which is called when the slot is selected in the graphical display (see
Chapter 3.12, "Burst editor", on page 45). You can define half rate slots. The charac-
teristics of each half rate slot can be defined separately. Each active slot is represented
by a burst symbol. Two half rate slots occupy the space of a full rate slot. A slot in
which the level has been attenuated is represented by a lower amplitude burst. Inactive
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Mode framed (single)

slots (Slot Level = Off) are shown as a horizontal bar. Defined multislots are banded
and surrounded by a frame.

When a half rate slot has been selected, two frames are generated alternately. Each
frame holds one of the two half rate users.

Example:

The following configuration is set, from a frame with two slots that contain half rate
users:

Frame: Select Slot To Configure

GMSK /[ . ) GMSK

As a result, the following two frames are generated alternately:
® Frame with half rate user 1:

— X

Tri | Clock ; :
wlFramEd (SmgIE) CDI.Iﬁguratlnﬂl_

Frame: Select Slot To Configure

Frame
Norm Norm
GMSK / B B . & GMSK [/ B |

0 1 2 3 4 5 6 7

SavelRecaII Frame ...

® Frame with half rate user 2

— X

Trigger In Clock - -
|Fram9d (SmgIE) cnnﬁguratlnnl
Frame: Select Slot To Configure R
Frame
Norm _ N . / Norm X !
MK T e R\ MK T

0 1 2 3 4 5 6 7

Save}RecaII Frame ...

Save/Recall Frame ...
Access the "Save/Recall Frame" dialog for selecting of predefined or user defined
frames, see Chapter 3.9, "Save recall frame/slots", on page 30.
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Mode framed (double)

Remote command:
n.a.

3.8 Mode framed (double)

1. To access this dialog select "General > Sequence Mode > Framed (Double)".

2. Select "Framed (Double) Configuration”.

— X

Trigger In Clock .
Framed (DDUbIE) cnnﬁguratlnn _

Frame 1: Select Slot To Configure

'—‘ Frame 1
Norm

Frame Repetition

=P Save/Recall Frame .

This dialog displays the frame structure and gives access to the dialog for saving
and loading a frame structure.

The "Framed (double)" mode generates multiframe signals which are defined by the
structure of two frames.

For this purpose, two frames are defined as in "Framed (single)" mode. A repetition
factor is then specified for each of the two frames. Following a trigger the first frame is
repeated the specified number of times, and then the second frame. The frame struc-
tures are repeated cyclically, but the useful data is continuously generated.

If one of the frames contains half rate slots (and so actually consists of two frames
itself), the repetition factor must be a multiple of 2 (seeChapter 3.7, "Mode framed (sin-
gle)", on page 27 ).

The frame structure of the two frames is displayed in graphical form. Slot parameters
can be defined in the burst editor, which is called when the slot is selected in the
graphical display (seeChapter 3.12, "Burst editor", on page 45 ).

Save/Recall Frame ...
Provides access to the "Save/Recall Frame" dialog for selecting of predefined or user
defined frames, see Chapter 3.9, "Save recall frame/slots", on page 30 .

Remote command:
n.a.
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Frame Repetition
Sets the number of repetitions for frame 1 or frame 2. First frame 1 is repeated the
specified number of times, and then frame 2, then frame 1 starts again, and so on.

Remote command:
[ : SOURce<hw>] :BB:GSM: FRAMe<di>:REPetitions on page 64

3.9 Save recall frame/slots

1. To access these dialogs select "General > Sequence Mode > Framed (Single) /
Framed (Double)".

2. Select "Framed (Single) / Framed (Double) Configuration" .
3. To access the "Save/Recall Frame" dialog, select "Save/Recall Frame"

4. To access the "Save/Recall Slots " dialog, select "Frame x: Select Slot to configure
> Slot... > Save/Recall Slots"

The "File Select" dialogs save and load (i.e. recall) user-defined frames or slots. Prede-
fined frames or slots can also be recalled. Each dialog offer access to the "File Man-
ager" for general file management.

Predefined Frames and Slots are stored on a predefined path. This path is automati-
cally set in the "File Select" dialog.

In the Normal Symbol Rate mode, user-defined Frames and Slots are stored as files
with the specific file extensions * .gsm fu or *.gsm slu, respectively.

In the Higher Symbol Rate mode, user-defined Frames and Slots are stored as files
with the specific file extensions *.gsm hfu or *.gsm_hslu, respectively. Independ-
ent of the selected symbol rate mode, the files with user-defined Frames and Slots can
be stored in a user-determined directory and called from there.

It is not possible to use other file extensions. Attempting to do so causes an error mes-
sage. If the file extension is modified (e.g. by directly accessing the file system), the
files are no longer recognized and therefore invalid.

In the following examples of commands, the files are stored in the default directory
which is defined by command MMEM: CDIRectory.

Recall Predefined Files
Accesses the standard "File Select" dialog for loading a predefined frame/slot.

"EDGEQ" Predefined frame

Slot 0 = On, full level, EDGE burst, all other slots off.
"EDGEAII" Predefined frame

All slots On, full level, EDGE burst
"GsmEdge" Predefined frame

Alternately one slot with NORMAL burst and EDGE burst
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"NormalBurst0"
Predefined frame
Slot 0 = On, full level, NORMAL burst (full rate), all other slots off

"NormalBurstAll"
Predefined frame
All slots On, full level, NORMAL burst (full rate)

"GSM_NB_PN9_TSCO0"
Predefined slot
NORMAL burst (full rate), full level, attenuation A1, multislot = Off,
number of multislots = 1, Data = PRBS 9, Use Stealing Flag = On,
TSCO, all slot-marker set to "all down".

"GSM_NB_PN9 TSCO0"
Predefined slot
EDGE burst (full rate), full level, attenuation A1, multislot = Off, num-

ber of multislots = 1, Data = PRBS 9, Use Stealing Flag = On, TSCQO,
all slot-marker set to "all down"

Remote command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : PREDefined:CATalog? on page 71
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : PREDefined:LOAD on page 72

[ :SOURce<hw>] :BB:GSM][ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] : PREDefined:CATalog? on page 72

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :SUBChannel<us>] [ :
USER<ch>] : PREDefined:LOAD on page 72

Recall User Files
Access the standard "File Select" dialog for loading a user-defined frame/slot.

Remote command:

[ : SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt:CATalog? on page 70

[ :SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt:LOAD on page 71

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ULISt:CATalog? on page 73

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ULISt:LOAD on page 73

Save User Files
Access the standard "File Select" dialog for saving the current frame or slot settings.

Remote command:

[ :SOURce<hw>] :BB:GSM:FRAMe<di>:ULISt:STORe on page 71

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ULISt:STORe on page 74

File Manager

Access the standard "File Manager" dialog, used to copy, delete and rename files and
to create directories.
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Remote command:

[ :SOURce<hw>] :BB:GSM: FRAMe<di>:ULISt:DELete ONn page 70

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ULISt:DELete on page 73

3.10 Modulation/filter

This dialog provides access to the modulation and filter settings. The selected symbol
rate mode and symbol rate determine the available modulation types.

Access:
1. Select "Baseband > GSM/EDGE > General".
2. Select "Modulation/Filter...."

This dialog contains the settings required for configuring the modulation types, the
corresponding filter settings and the ARB settings.

"Higher Symbol Rate Mode", AQPSK modulation and higher order modulations
(16QAM and 32QAM) are with option R&S SMM-K41 (EDGE evolution).

3.10.1 General settings

Access:

» Select "General".

GSM/EDGE A: Modulation/Filter

IR MSK / FSK [AQPSK |8 PSK / EDGE | 16QAM | 320AM _

Symbol Rate

270.833 333 ksym/s
Ignore 1/4 sym (slot length 156 sym) ]
Force Dummy Bits to 1 ]

This tab contains the parameters to configure the general modulation settings.
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Modulation/filter

Settings:

SYMDOI RAE.....ceiiieiiii e e 33
Ignore 1/4 symbol (slot length 156 sym) / Ignore %2 symbol (slot length 187 sym)....... 33
Force DUMMY BitS 10 ..o e e e e e e e e e e e 33
Symbol Rate

Sets the symbol rate.

The symbol rate is determined by the selected "Symbol Rate Mode":
® "Normal Symbol Rate"

Sets 270.833 33 ksymb/s default symbol rate for GSM/EDGE.
® "Higher Symbol Rate"

Sets 325 ksymb/s default symbol rate for EDGE evolution.

Remote command:
[ :SOURce<hw>] :BB:GSM: SRATe on page 68

Ignore 1/4 symbol (slot length 156 sym) / Ignore "> symbol (slot length 187 sym)
Selects constant slot length. This setting affects all burst types.

In a normal burst (NB), the GSM slot has a length of 156.25 symbols. Compensation
for the 1/4 symbol takes the form of an extra symbol every 4th slot. This means that
some slots are 156 long and some are 157 long. Compensation takes place in the
guard field of the burst (seeChapter 3.12, "Burst editor", on page 45 ).

In a higher symbol rate burst (HB), the average slot is 187.5 symbols long. Compensa-
tion for 72 symbol means that each second slot gets an extra symbol and is 188 sym-
bols long, while the rest uses a slot length of 187 symbols.

If the field "Ignore 1/4 symbol (slot length 156 symbols) / Ignore 2 symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra
1/4 resp. V> symbol is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is than 1496 sym-
bols long instead of 1500 symbols.

Remote command:
[ :SOURce<hw>] :BB:GSM: ISLength on page 64

Force Dummy Bits to 1

A modulating bitstream consisting of consecutive ones is used for inactive slots
(according to GSM 05.04). If this parameter is disabled, the inactive slots are filled in
with 0.

Remote command:
[ :SOURce<hw>] :BB:GSM: FONE on page 64
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3.10.2 MSKI/FSK settings

Access:
1. Select "Symbol Rate Mode > Normal Symbol Rate".
2. Select "MSK/FSK".

GSM/EDGE A: Modulation/Filter

Modulation
FSK 1bit/sym
FSK Deviation
67.708 3 kHz
Filter @ Filter Parameter
Gauss 0.30

This tab contains the parameters required to configure the MSK/FSK modulation.

1Y/ [T 1U] F=1 10 1R 34
[RESY G DAY/ E= 1 ([0] o 1T 34
[T L= ST 34
R L g =T =1 4 1= (= 35
Modulation

Selects the modulation type for the GSM signal.

e "MSK 1bit/symbol" = Minimum Shift Keying
® "FSK 1bit/symbol" = Frequency Shift Keying

The selected modulation is also displayed in graphical form.

Remote command:
[ : SOURce<hw>] :BB:GSM: FORMat on page 74

FSK Deviation
Sets the deviation for FSK.

When MSK is selected, the deviation is set permanently to symbol_rate/4.

Remote command:
[ :SOURce<hw>] :BB:GSM: FSK:DEViation on page 75

Filter
Indicates the filter used for the GSM signal. The filter is permanently set to Gauss.

User Manual 1179.2048.02 — 05 34



R&S®SMM-K40/-K41

GSM/EDGE configuration and settings

Modulation/filter

Remote command:
[ :SOURce<hw>] :BB:GSM:FILTer: TYPE? on page 79

Filter Parameter
Sets the BxT value for the GAUSS filter. The GSM default value is 0.3.

Remote command:
[ :SOURce<hw>] :BB:GSM: FILTer : PARameter on page 79

3.10.3 AQPSK settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. Select "AQPSK".

GSM/EDGE A: Modulation/Filter — X

e - e e
Modulation '
25
Angle a_0 SCPIR_O Angle a_1 SCPIR_1
45.000 0 deg 0.0000dB 45.000 0 deg 0.0000dB
Angle a_2 SCPIR_2 Angle a_3 SCPIR_3
45.000 0 deg 0.0000dB 45.000 0 deg 0.0000dB
Angle a_4 SCPIR_4 Angle a_5 SCPIR_S
45.000 0 deg 0.000 0 dB 45.000 0 deg 0.0000dB
Angle a_6 SCPIR_6 Angle a_7 SCPIR_7
45.000 0 deg 0.0000dB 45.000 0 deg 0.0000dB
Filter j
Gauss linear

This tab contains the parameters necessary to configure the AQPSK modulation
(requires option R&S SMM-K41.

Modulation AQPSK

Displays the modulation type for the GSM signal. The modulation type is set perma-
nently to AQPSK (see Chapter 2.3, "VAMOS (voice services over adaptive multi-user
channels on one slot)", on page 11).

Remote command:
[ :SOURce<hw>] :BB:GSM:AQPSk:FORMat? on page 75

Angle alpha_0 ... alpha_7
Sets the angle alpha (see Chapter 2.3, "VAMOS (voice services over adaptive multi-
user channels on one slot)", on page 11).

Remote command:
[ : SOURce<hw>] : BB:GSM: AQPSk: ANGLe<ch0> on page 78
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SCPIR_0 to SCPIR_7
The power level of subchannel 1 relative to the power level of subchannel 2 is called
subchannel power imbalance ratio (SCPIR). It is related to the angle a as follows:

SCPIR = 20 * log(tan a) dB,
Where the value of a is chosen such that [SCPIR|<10dB
For a = 45° the SCPIR equals 0 dB and the two power levels are equal.

Remote command:
[ : SOURce<hw>] :BB:GSM: AQPSk: SCPIR<ch0> on page 78

Filter
Indicates the filter type used for AQPSK modulation. The filter is permanently set to
Gauss linearized.

Remote command:
[ :SOURce<hw>] :BB:GSM:FILTer:AQPSK:TYPE? on page 79

3.10.4 8 PSKI/EDGE settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. Select "8 PSK/EDGE".

GSM/EDGE A: Modulation/Filter

Modulation -

Filter 9
Gauss linear

This tab contains the parameters required to configure the 8 PSK/EDGE modula-
tion.

Modulation Type EDGE

Displays the modulation type for the EDGE signal. The modulation type is set perma-
nently to 8PSK EDGE (3pi/8 8PSK). Unlike the modulation types for GSM, the modula-
tion type for EDGE has 3 bits per symbol.

Remote command:
[ : SOURce<hw>] :BB:GSM:EDGE: FORMat? on page 75
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Filter
Indicates the filter used for the EDGE signal. The filter is permanently set to Gauss lin-
earized.

Remote command:
[ :SOURce<hw>] :BB:GSM: FILTer:EDGE: TYPE? on page 80

3.10.5 16QAM settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. Select"16 QAM".

GSM/EDGE A: Modulation/Filter

Modulation
16QAM EDGE

Filter 9
Gauss linear

This tab contains the parameters required to configure the 16 QAM modulation.
(requires option R&S SMM-K41)

Modulation Type 16QAM
Displays the modulation type for the signal.

The modulation type 16QAM has 4 bits per symbol.

Remote command:
[ : SOURce<hw>] :BB:GSM:N16Qam: FORMat? on page 77

Filter
Indicates the filter used for the 16QAM signal. The filter is permanently set to Gauss
linearized.

Remote command:
[ :SOURce<hw>] :BB:GSM:FILTer:N16Qam: TYPE? on page 80
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3.10.6 32QAM settings

1. To access this dialog select "Symbol Rate Mode > Normal Symbol Rate".

2. Select "32 QAM".

GSM/EDGE A: Modulation/Filter

Modulation

32QAM EDGE

Filter 9
Gauss linear

This tab contains the parameters required to configure the 32QAM modulation.
(requires option R&S SMM-K41)

Modulation Type 32QAM
Displays the modulation type for the signal.

The modulation type 32QAM has 5 bits per symbol.

Remote command:
[ :SOURce<hw>] :BB:GSM:N32Qam: FORMat? on page 77

Filter
Indicates the filter used for the 32QAM signal. The filter is permanently set to Gauss
linearized.

Remote command:
[ :SOURce<hw>] :BB:GSM:FILTer:N32Qam: TYPE? on page 80

3.10.7 HSR QPSK settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".
2. Select "HSR QPSK".
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GSM/EDGE: Modulation/Filter

Modulation
QPSK EDGE

Filter
Narrow Pulse Shape,
Wide Pulse Shape

This tab contains the parameters required to configure the HSR QPSK modulation.
(requires option R&S SMM-K41)

Modulation Type HSR QPSK
(for "Higher Symbol Rate")

Displays the modulation type for the signal.
The modulation type QPSK EDGE has 2 bits per symbol.

Remote command:
[ : SOURce<hw>] :BB:GSM: HQPSk:FORMat? on page 77

Filter
(for "Higher Symbol Rate")

Indicates the filters used for the HSR QPSK EDGE signal.

The two possible filters are displayed. The currently used filter is set per HSR QPSK
slot with the parameter "Filter".

Remote command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[:SUBChannel<us>] [:
USER<ch>] :FILTer:TYPE on page 94

[ : SOURce<hw>] :BB:GSM: FILTer : HQPSk: TYPE on page 81

3.10.8 HSR 16QAM settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".
2. Select "HSR 16QAM".

GSM/EDGE: Modulation/Filter

Modulation
16QAM EDGE

Filter
Narrow Pulse Shape,
Wide Pulse Shape

This tab contains the parameters required to configure the HSR 16QAM modula-
tion.
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Modulation Type HSR 16QAM
(for "Higher Symbol Rate")

Displays the modulation type for the signal.
The modulation type 16QAM has 4 bits per symbol.

Remote command:
[ :SOURce<hw>] :BB:GSM: H16Qam: FORMat? on page 76

Filter
(for "Higher Symbol Rate")

Indicates the filters used for the HSR 16QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 16QAM
slot with the parameter Filter.

Remote command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :FILTer:TYPE on page 94

[ :SOURce<hw>] :BB:GSM:FILTer:H32Qam: TYPE on page 81

HSR 32QAM settings

1. To access this dialog select "Symbol Rate Mode > Higher Symbol Rate".
2. Select "HSR 32QAM".

GSM/EDGE: Modulation/Filter

Modulation
320AM EDGE

Filter
Narrow Pulse Shape,
Wide Pulse Shape

This tab contains the parameters required to configure the HSR 32QAM modula-
tion.

Modulation Type HSR 32QAM
(for "Higher Symbol Rate")

Displays the modulation type for the signal.
The modulation type 32QAM has 5 bits per symbol.

Remote command:
[ : SOURce<hw>] :BB:GSM:H32Qam: FORMat ? on page 76

Filter
(for "Higher Symbol Rate")

Indicates the filters used for the 32QAM signal.
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3.1

Power ramping/slot attenuation

The two possible filters are displayed. The currently used filter is set per HSR 32QAM
slot with the parameter Filter.

Remote command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :FILTer:TYPE on page 94

[ :SOURce<hw>] :BB:GSM:FILTer:H32Qam: TYPE on page 81

ARB settings

Access:
1. Select "Baseband > GSM/EDGE > General".
2. Select "Modulation/Filter.... > ARB"

GSM/EDGE A: Modulation/Filter/ARB

Sequence Length

1 Frames

This tab contains the parameters required to configure the ARB waveform compo-
nent of the signal.

Sequence Length ARB
Sets the sequence length of the arbitrary waveform component of the signal. This com-
ponent is calculated in advance and output in the arbitrary waveform generator.

The maximum number of frames depends on the installed ARB waveform memory size
and the current "Symbol Rate".

Remote command:
[ :SOURce<hw>] :BB:GSM: FLENgth on page 63

Power ramping/slot attenuation

This dialog provides access to the settings for power ramping and level attenuation.

You can set the power ramp envelope, and define seven possible values for level
attenuation. Slot Attenuations, used in burst editors enables you to define seven possi-
ble values for level attenuation. These values can be selected from the burst editor for
the slot currently being edited. An eighth value is permanently set to 0 dB and corre-
sponds to the "Slot Level Full" setting in the burst editor.

Power ramping /Level attenuation is used for restricting power ramping to the base-
band signal.
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Access:
1. Select "Baseband > GSM/EDGE".

2. Select "Power Ramp/Slot Attenuation"

This dialog contains the parameters required to configure the power ramp enve-
lope and the slot attenuations.

GSM/EDGE A: Power ../ Slot Attenuations

Puwer Ramp
P Slot Attenuations . In Bb Only -|

Ramp Function
Cosine
Ramp Time
2.0 sym
Rise Delay
0.00 sym
Fall Delay
0.00 sym

3. Select "Slot Attenuations".

GSM/EDGE A: Power .../ Slot Attenuations [ ) 4

Power Ramp :
Slot Attenuations . In Bb Only -|

A1 A2

0.0dB 0.0dB
A3 Ad

0.0dB 0.0dB
A5 Ab

0.0dB 0.0dB
A7

0.0dB

You can define the seven values for level attenuation.
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4. Select "Power Ramping/ Level Attenuation"

GSM/EDGE A: Power .../ Slot Attenuations
-I

In Baseband Only
is Not On

Enable the provided parameter to restrict power ramping to the baseband signal.

Power Ramp
Access:

Select "Baseband > GSM/EDGE > Power Ramp Slot Attenuations > Power Ramp".

Ramp Function < Power Ramp
Sets the form of the transmitted power during the switching operation, i.e. the shape of
the rising and falling edges of the envelope.

"Linear" The transmitted power rises and falls linear fashion.

"Cosine" The transmitted power rises and falls with a cosine-shaped edge.
This causes a more favorable spectrum than the "Linear" setting.

Remote command:
[ : SOURce<hw>] :BB:GSM: PRAMp : SHAPe on page 91

Ramp Time — Power Ramp
Sets the power ramping rise time and fall time for a burst. The setting is expressed in
symbols.

Do not switch the transmitted power abruptly at the start and end of a burst, because
the switching operation would otherwise generate excessively strong non-harmonics.
The switching operation is therefore stretched over several symbol clocks.

Remote command:
[ : SOURce<hw>] :BB:GSM: PRAMp : TTME on page 91
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Rise Delay < Power Ramp

Sets the offset in the rising edge of the envelope at the start of a burst. A positive value
causes a delay and a negative value causes an advance. The setting is expressed in
symbols.

Remote command:
[ : SOURce<hw>] : BB:GSM: PRAMp : RDELay on page 90

Fall Delay < Power Ramp

Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
causes a delay and a negative value causes an advance. The setting is expressed in
symbols.

Remote command:
[ :SOURce<hw>] :BB:GSM: PRAMp: FDELay on page 90

Slot Attenuations
Access:

Select "Baseband > GSM/EDGE > Power Ramp Slot Attenuations > Slot Attenuations".

Slot Attenuation A1 to A7 «— Slot Attenuations
Sets the seven different values for level attenuation.

The burst editor can be used to set the level attenuation for the eight slots to one of
these predefined values independently of one another.

The burst editor is likewise used to assign the "Slot Level" attribute "Attenuated" to
individual slots.

Remote command:
[ :SOURce<hw>] :BB:GSM: SATTenuation<ch> on page 66

In Bb Only
Access:

Select "Baseband > GSM/EDGE > Power Ramp Slot Attenuations > In Bb Only".

In Baseband Only < In Bb Only
Restricts power ramping to the baseband signal.

"Off" Level attenuation is effected via the attenuator stages in the RF sec-
tion; only the remaining part is attenuated in the baseband. The sig-
nal is issued at the RF output with the defined level values. This set-
ting provides the best possible dynamic for burst signals.
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"On" Level attenuation affects the baseband only.

This setting is mandatory in the following cases:

® When only the baseband signal is issued at the 1/Q outputs
It is thus ensured that, with power ramping active, this signal is
output with the defined level values.

® \When a baseband signal is applied to two RF paths of a two-path
instrument.
The RF paths having separate frequency and level settings, the
remaining attenuation in the baseband would have to be different
for the two paths and is therefore not possible.

® When a burst baseband signal (GSM/EDGE) is combined with a
continuous baseband signal (e.g. 3GPP), or a noise signal and
both signals are applied to one RF path.
Blanking in the RF is unsuitable, because the RF section would
not only blank the burst signal of the first baseband but also the
continuous signal or the noise signal.

Remote command:
[ : SOURce<hw>] :BB:GSM: PRAMp: BBON1ly [ : STATe] on page 89

3.12 Burst editor

This dialog provides the settings for configuring a burst slot. The burst type for the
selected slot, for example the burst structure determines the available parameters.

Access:

1.
2.
3.

Select "Baseband > GSM/EDGE > General".
Select the "Sequence Mode"

Depending on the "Sequence Mode", select:

e "Unframed Configuration" or
e "Framed (Single) Configuration" or
e "Framed (Double) Configuration".

The corresponding dialog opens and displays a graph of the current frame.

In the frame graph "Frame: Select Slot To Configure", select a slot.
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Burst Type ,
yP - SavefRecaII Slots ...
Normal (GMSK / Full Rate)
Slot Level Slot Attenuation
Full
. . . Number Of Slots
Multislot Configuration ]
. il 4]
VAMOS Offset Jitter ]
0.0 Hz 0.0 Hz
Data S TSC S Data
57 1 26 1 57

This dialog contains the parameters for configuring a burst slot. The graph shows
the structure of the current burst type.

The individual fields of the burst type are color-coded:

Field Color
Data, Fixed, Mixed, Stealing white

Training Sequences: TSC, ETSC, SYNC yellow
Tail, extended Tail green
Guard, extended Guard blue

"Higher Symbol Rate Mode", AQPSK modulation and higher order modulations
(16QAM and 32QAM) require optionR&S SMM-K41 (EDGE evolution).

Settings:
U= A 1Y/ o T Y USRS 47
SAVE/RECAI SIOLS... .ottt e e e e e e e e e et e e e e e e e a e enaaas 50
(O LY O TR 50
S P I R e e 50
5] (o] A SNV F TR 51
] Lo A N £ (=1 A1 F= 1 1 o) o 51
1L = 51
Multislot ConfIQUIatIoN. ... e 51
INUMIDEE OFf SIOLS.... et e e e et e e e e e ea e e e e e enanaans 52
BUISE FIEIAS. ...t e et e e e e e et e e e e e e s e e e en e e s e e enanas 52
L EXEENAEA Tal BItS...eveveeeeeeeeeeeeeeeeeeeteeeeeeeeeeeeeeeeeesereeeeseeeessseeeeeseeneeeseneeenenaeene 52
L Tl BItS..eeeeeeeeeeeeeeee ettt et e et et e e e et st e e e et et st e e n e ee e e 53
L Data for Data FIeld Of SIOt......cweweeeeeeeeeeeeee e eee et ee e eee e eeeeeeeeeeeeeeeeen. 53
L USE StEAING FIAG.. . eceeeieeeeeeeeeeeee ettt et ee e en s e e s e 54
S (=T LTaTe T 1= TR 54
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L TS0 St ettt ettt en e en e 54
L T S ettt ettt e et e et ee e en e e 54
L KT O3 =1 1=Y 1 1 TR SRRSO 54
L Ext Training S€G ETSC...ouveeieeececeeeceeeeeeeeeee e e eesesasesae et esss s s s nenasenenens 55
L ETSC PatterN... ettt ettt st s n e 55
L Training SEQUENCE SYNC.....c.voveiieeeeeeeeeeeeeeeeee e et ee et ee e en et en e 55
L SYNC PAEIMN.... ettt an e 55
L FIXE. ettt ettt et e et et e et et e eeneneennen e 55
O G o I o= 140 8 YOS 56
L MIIXE. .ottt ettt et en et e e e e e enen e en e e nanene 56
L TUT- o IR R 56
O (= a1 (Yo R CTU L= (o PRSP 57
SIot Marker DefiNitiON.......civueiiii et e e e e e e e s e e e b e e eaneesens 57
Burst Type

Selects the burst type.

The burst types available depend on the selected "Symbol Rate Mode". The symbol
rate mode a burst type applies to is denoted ("Normal ..." and "HSR ..." ("high symbol
rate mode").

Note: "Higher Symbol Rate Mode", AQPSK modulation and higher order modulations
(16QAM and 32QAM) require optionR&S SMM-K41 (EDGE evolution).

"Normal (GMSK/Full Rate)"
The useful data is transmitted in the normal burst (NB).
A normal burst carries 2*58 = 116 encrypted bits.

D S TSC S D
H B % T o |5 eee
"Normal (GMSK/Half Rate)"
The useful data is transmitted in the normal burst.
Half rate user 1 is transmitted in all the frames with an even index
(frames 0, 2, 4, etc.). Half rate user 2 is transmitted in the frames with

an odd index (frames 1, 3, etc.).
See alsoChapter 3.7, "Mode framed (single)", on page 27 .

User 2

. Data TSC Data -. Data TSC H Data -
57

"Normal (AQPSK/Full Rate - Full Rate)"
The data of pair of users is multiplexed on the two VAMOS subchan-
nels of a single physical radio resource.
See also Chapter 2.3, "VAMOS (voice services over adaptive multi-
user channels on one slot)", on page 11.

Subchannel Sub Channel 2

. Data HTsc Data -. Data TSC H Data -
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"Normal (AQPSK/Full Rate - Half Rate)"

Three users are using the same radio resource, one full rate VAMOS
user on the subchannel 1 and two half rate VAMOS users on the sub-
channel 2.

SubChannel 1 SubChannel 2

User 1 User 2
Data [S|TSC |S| Data Data [S|TSC |S| Data
57 26 57 57 26 57

"Normal (AQPSK/Half Rate - Half Rate)"

A single timeslot is shared by four users: two VAMOS subchannels,
each used by two half rate users.

SubChannel 1 SubChannel 2

User 1 User 2 User 1 User 2

"Normal (8PSK/EDGE)"

The higher bit clock associated with EDGE achieves correspondingly
higher data transfer rates.

If a frame contains an active EDGE burst, the higher bit clock (3 x
symbol clock) is always output on the clock outputs. If the EDGE
burst is removed from the frame, the lower bit clock (=symbol clock)
is automatically output again.

An EDGE burst carries 2x(3*58) = 348 encrypted bits.

Data ‘ TSC ‘ Data
174 78 174

"Normal (16QAM)"

"Normal
(32QAM)"

"Synchroniza-
tion"

"Frequency
Correction”

User Manual 1179.2048.02 — 05

Selects a normal burst with 16QAM modulation scheme (4 bits per
symbol).
A normal 16QAM burst carries 2x(4*58) = 464 encrypted bits.

B = = = ¢FiE
Selects a normal burst with 32QAM modulation scheme (5 bits per
symbol).
A normal 32QAM burst carries 2x(5*58) = 580 encrypted bits.

Data TSC Data
B o T % 0 % [

(Normal Symbol Rate)

The synchronization burst is sent by the base station only and is used
for bit synchronization. For this purpose, it contains a 64-bit extended
training sequence.

Data ETSC Data
. 39 ‘ 64 39
(Normal Symbol Rate)
The Frequency Correction burst is sent by the base station only. The

user equipment uses the burst to synchronize with the carrier fre-
quency and to compensate for any possible Doppler effect.

Fixed
142
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"Dummy" (Normal Symbol Rate)
The dummy burst is sent by the base station only. It acts as a modu-
lation signal when there is no data burst available. This burst type is
defined in the standard and has an unalterable, precisely defined
data pattern.

. Fixed
142

"Access" (Normal Symbol Rate)
This burst type is sent by a user equipment to a base station as the

first burst, to determine the timing advance. It is used for synchroniz-
ing with the base station.

- Sync ‘ Data
41 36
"All Data (Normal Symbol Rate)
(GMSK)" This and the following normal symbol rate burst types are not defined
in the standard. They serve as the output basis for defining a new

burst type with user-programmable data content for test purposes.
An All_Data GMSK burst carries 148 encrypted bits.

Data
148
"All Data An All_Data AQPSK burst carries 148 encrypted bits per subchannel.
(AQPSK)“ SubChannel 1 SubChannel 2
148 148
"All Data (Normal Symbol Rate)

(8PSK/EDGE)" An All_Data EDGE burst carries 3x148 = 444 encrypted bits.

444

"All Data (Normal Symbol Rate)

(16QAM)" An All_Data 16QAM burst carries 4x148 = 592 encrypted bits.
592

"All Data (Normal Symbol Rate)

(32QAM)" An All_Data 32QAM burst carries 5x148 = 740 encrypted bits.
Data
740

"HSR (QPSK)" (Higher Symbol Rate)
Selects a higher symbol rate burst with QPSK modulation scheme (2
bits per symbol).
A higher symbol rate burst carries 2*69 = 138 unmodulated encrypted
bits, i.e. an HSR QPSK burst carries 2x(2*69) = 276 encrypted bits.

Data TSC Data
138 62 138

User Manual 1179.2048.02 — 05 49



R&S®SMM-K40/-K41 GSM/EDGE configuration and settings

Burst editor

"HSR (Higher Symbol Rate)

(16QAM)" Selects a higher symbol rate burst with 16QAM modulation scheme
(4 bits per symbol).
An HSR 16QAM burst carries 4x(2*69) = 552 encrypted bits.

. Data TSC Data -
276 124 276

"HSR (Higher Symbol Rate)

(32QAM)" Selects a higher symbol rate burst with 32QAM modulation scheme

(5 bits per symbol).
An HSR 32QAM burst carries 5x(2*69) = 690 encrypted bits.

Data TSC Data
345 155 345
"HSR All Data  (Higher Symbol Rate)
(QPSK)" This and the following higher symbol rate burst types are not defined

in the standard. They serve as the output basis for defining a new
burst type with user-programmable data content for test purposes.
An HSR All_Data QPSK burst carries 2x177 = 354 encrypted bits.

Data
354

"HSR All Data  (Higher Symbol Rate)

(16QAM)" An HSR All_Data 16QAM burst carries 4x177 = 708 encrypted bits.
Data
708

"HSR All Data  (Higher Symbol Rate)

(32QAM)" An HSR All_Data 32QAM burst carries 5x177 = 885 encrypted bits.
885

Remote command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>: TYPE on page 92

Save/Recall Slots
Accesses the "Save/Recall Slot" dialog with standard "File Select" and file manage-
ment functions, see Chapter 3.9, "Save recall frame/slots", on page 30.

Remote command:
n.a.

User x
When burst type "Normal (Half Rate)" is selected, the users can be set separately in
dialog sections User 1 and User 2.

Remote command:
n.a.

SCPIR
Selects the SCPIR.
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The value of SCPIR affects the shape of the AQPSK constellation, see Figure 2-2. For
an SCPIR of 0 dB, the constellation is square (as in "normal" QPSK), while for other
values of SCPIR the constellation becomes rectangular.

Use the Modulation/filter dialog to define eight different values for SCPIR. You can
select from the values displayed.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :SCPIRatio on page 94

Slot Level

Sets the level for the selected slot.

"Off" Attenuation is maximum. The slot is inactive.

"Attenuated" Level is reduced by the level attenuation set in "Slot Attenuation"”.
"Full" The level corresponds to the level indicated in the display.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :LEVel on page 93

Slot Attenuation
Selects the level attenuation for the "Slot Level Attenuated" setting.

Use the Power ramping/slot attenuation dialog to define seven different values for level
attenuation. You can select from the values displayed.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ATTenuation on page 93

Filter
(Higher Symbol Rate slots require R&S SMM-K41)

Selects whether a "Narrow Pulse Shape" or a "Wide Pulse Shape" filter is used for the
selected burst type and modulation.

Remote command:
[ : SOURce<hw>] :BB:GSM][ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :FILTer:TYPE on page 94

Multislot Configuration
Enables the previously set multislot mode.

Since multislot involves connecting multiple slots to a single user channel, this configu-
ration is possible for normal (full rate) bursts, normal (8PSK/EDGE) burst and EDGE
evolution bursts.

Several multislot groups can be defined within a frame. These groups are highlighted
when the frame structure is displayed in the main dialog (see Chapter 3.7, "Mode
framed (single)", on page 27).
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Frame: Select Slot To Configure

Frame
Norm Norm Norm Norm Norm Norm
GMSK GMSK GMSK GMSK GMSK GMSK
0 1 2 3 4 5 6 7

Save/RecaII Frame ...

The first slot in a multislot group is the primary slot. This determines the parameters of
all the slots in the group. All the slots in a multislot group therefore have identical
parameters.

The multislot settings are valid for all the slots in the frames of a multiframe configura-
tion. If slots 1 and 2 are connected, for example, both these slots are connected in all
the frames of the multiframe signal.

Remote command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] :MULTislot<st0>:STATe on page 97

Number of Slots
Defines the number of consecutive slots that are linked to a multislot.

The multislot always starts with the current slot. The value range therefore depends on
the current slot index. A maximum of eight slots (slot O to slot 7) can be combined: 1 ...
(8 - current index).

Remote command:
[ : SOURce<hw>] :BB:GSM|[ : FRAMe<di>] :MULTislot<st0>:COUNt on page 94

Burst Fields
Comprises settings for configuring of the individual burst fields.

Normal (GMSK)

. Data S TSC S Data - Burst Fields
57 1 26 1 57
Data
PRBS 9 |
Stealing Flag .
TSC Set TSC TSC Pattern
Set 1v TsC gv 0010010...
Tail Bits j Guard j
000 11111 1111
@Slol Marker Definition ...

The available settings depend on the selected Burst Type.

Extended Tail Bits < Burst Fields
Displays the data content in the "ETail" data field of the access burst.

Extended tail bits fields are 8 bits long and permanently set at 0011 1010.
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Remote command:
n.a.

Tail Bits < Burst Fields
Displays the data content in the "Tail" data field.

The content depends on the "Burst Type":
® Normal (GMSK...), normal (AQPSK...), synchronization, Frequency Correction,
dummy and access
"Tail Bit" field is 3 bits long and permanently set at 000.
® Normal(8PSK/EDGE)
"Tail Bit" field is 9 bits long and permanently setat 1 1111 1111.
® Normal (16QAM)
"Tail Bit" field is 12 bits long and permanently set at 0001 0110 0110.
e Normal (32QAM)
"Tail Bit" field is 15 bits long and permanently set at 111 1001 1100 1110.

Remote command:
n.a.

Data for Data Field of Slot < Burst Fields
Selects a data source for the DATA field.

If a burst contains multiple DATA fields, these are treated as a continuous field. For
example, a pseudo-random sequence is continued without interruption from one DATA
field to the next.

The following standard data sources are available:

e "AllO, All 1"

An internally generated sequence containing O data or 1 data.
® "PNxx"

An internally generated pseudo-random noise sequence.
e "Pattern”

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.
® "Data List/Select DList"

A binary data from a data list, internally or externally generated.

Select "Select DList" to access the standard "Select List" dialog.

— Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to
select an existing data list.

— Use the "New" and "Edit" functions to create internally new data list or to edit
an existing one.

— Use the standard "File Manager" function to transfer external data lists to the
instrument.

See also:

® Section "Modulation Data" in the R&S SMM100A user manual.

® Section "File and Data Management" in the R&S SMM100A user manual.
® Section "Data List Editor" in the R&S SMM100A user manual
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Remote command:

[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ :SUBChannel<us>] [ :
USER<ch>] [ :SOURce] : DATA on page 95

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ : SOURce] : DATA: PATTern on page 97

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ : SOURce] : DATA:DLISt:CATalog? on page 96

[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ :SOURce] : DATA:DLISt on page 96

Use Stealing Flag — Burst Fields

Sets the use stealing flag feature. The setting applies to both S fields. If not used, the
flag stealing bit is allocated to the data field concerned, which then becomes 58 data
bits long instead of 57.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] : SFLag:USE on page 98

Stealing Flag < Burst Fields

Sets a value for the stealing flag feature. The setting applies to both S fields.
Remote command:

[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<stO0>[:SUBChannel<us>] [:
USER<ch>] : SFLag on page 98

TSC Set < Burst Fields
Determine whether the GMSK normal burst or VAMOS subchannel uses training
sequence TSC set 1 or set 2.

Assign different TSC set to each of the two subchannels to ensure that the training
sequences configured for the VAMOS subchannels have a low cross-correlation.

Remote command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ :SOURce] : TSC: SET on page 99

TSC — Burst Fields
Selects the training sequence code.

There are 8 predefined training sequences to choose from in each case; those for
GSM are 26 bits long and those for EDGE are 78 bits.

A user-defined training sequence can be created in the User TSC field and is then also
available for selection.

Remote command:
[ : SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ :SOURce] : TSC: SELect on page 98

TSC Pattern — Burst Fields
Edits selected training sequence.

When a sequence has been changed, the TSC field displays the indication "User".
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When a frame/slot is saved, the amended training sequence is also saved.

User-defined training sequences can be used among other things to test the reaction
of receivers to interference-laden training sequences (e.g. 1-bit toggle).

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] [ :SOURce] : TSC:USER on page 99

Ext Training Seq ETSC < Burst Fields
Selects the extended training sequence code (ETSC) for the synchronization burst.

There is a choice of three predefined, 64-bit extended training sequences. Also, a
user-defined extended training sequence can be defined in the User ETSC field and is
then also available for selection.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :SUBChannel<us>] [:
USER<ch>] :ETSC on page 99

ETSC Pattern — Burst Fields
Edits selected ETSC for the synchronization burst.

When a sequence has been changed, the "Ext Training Seq ETSC" field also displays
"User" as a possible choice.

When a frame/slot is saved, the changed extended training sequence is also saved.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] :ETSC:USER on page 100

Training Sequence Sync — Burst Fields
Selects training sequence sync for the "Access" burst.

There is a choice of three predefined, 41-bit training sequences sync. Also, user-
defined training sequence sync can be defined in the "User Sync" field and is then also
available for selection.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[ :SUBChannel<us>] [:
USER<ch>] : SYNC:SELect on page 100

Sync Pattern < Burst Fields
Edits the training sequence sync for the access burst.

When a sequence has been changed, the "Training Sequence Sync" field also displays
"User" as a possible choice.

When a frame/slot is saved, the amended training sequence sync is also saved.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] : SYNC:USER on page 100

Fixed — Burst Fields
Selects the data content of the fixed field in the Frequency Correction burst.
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There is a choice of two fixed, 142-bit data contents prescribed by the standard, and a
user-defined one.

The user-defined pattern must be 142 bits long.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] : FCORrection:FIXed on page 101

Fixed Pattern <— Burst Fields
Displays the data content of the fixed field in the Frequency Correction burst when
"Fixed Standard" or "Compact" is selected.

Enter the data content of the fixed field in the Frequency Correction burst when "Fixed
User" is selected. The pattern is 142 bits long.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [:
USER<ch>] : FCORrection:FIXed:PATTern on page 101

Mixed — Burst Fields
Displays the data content of the mixed field in the dummy burst. It contains a fixed,
142-bit data content prescribed by the standard.

Remote command:
[ :SOURce<hw>] :BB:GSM[ : FRAMe<di>] : SLOT<st0>[ : SUBChannel<us>] [:
USER<ch>] : DUMMy :MIXed:PATTern? on page 102

Guard — Burst Fields
Displays the data content of the guard field in binary notation.

A frame contains exactly 1250 bits for normal burst and 1500 for higher symbol rate
burst. Hence, the length of the guard fields is different for different slots (see table).

Normal Symbol Rate

Slot # 0,4 1..8,6..7

Guard Length 9 symbol periods 8 symbol periods

Higher Symbol Rate

Slot # 0,2,4,6 1,3,57

Guard Length 11 symbol periods 10 symbol periods

If the field "Ignore 1/4 symbol (slot length 156 symbols) / Ignore 1/2 symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra
1/4 resp. 1/2 symbol is omitted. The guard field for the burst always has the same
length regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is than 1496 sym-
bols long instead of 1500 symbols.

Remote command:
n.a.

User Manual 1179.2048.02 — 05 56



R&S®SMM-K40/-K41 GSM/EDGE configuration and settings

Slot marker definition

Extended Guard — Burst Fields
Displays the data content of the extended guard field in the access burst.

In order for a frame to contain exactly 1250 symbols as prescribed in the GSM stan-
dard, the length of the extended Guard fields is different for different slots:

The field length is 68 bits in slots 1, 2, 3, 5, 6, 7; it is 69 bits in slots 0 and 4.

If the field "Ignore 1/4 symbol (slot length 156 symbols)" is enabled, all slots are 156
symbols long. The extra 1/4 symbol is omitted. The extended guard field for the burst
always has the same length regardless of the slot index. A frame is therefore 1248
symbols long in place of 1250.

Remote command:
n.a.

Slot Marker Definition
Access the dialog for defining the marker signal at slot level. This dialog is described in
theChapter 3.13, "Slot marker definition", on page 57 .

Remote command:
n.a.

3.13 Slot marker definition

1. To access these dialogs select "General > Sequence Mode > Framed (Single) /
Framed (Double)".

2. Inthe " Framed (Single) / Framed (Double) Configuration" tab, select "Frame:
Select Slot to configure > Slot... ".

3. Inthe common tab, select "Burst Type".

4. In the corresponding burst type tab, select "Slot Marker Definition".

Slot Marker GSM (Frame?1 : Slot0)

Select Ramp to Edit

Marker 1 . I

Marker2 [] .
Marker3 [] -

Total List Length

Length

376

Marker 1 Cursor Zoom

Preset Type Posmon Data e °| . |
All down 138 Zoomn Save
o Preset | | . Edit | Position in Data Bits Visible 1501
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This dialog displays the structure of the slot and comprises the settings for config-
uring a ramp.

The marker signals thus defined take only effect when marker mode "As defined in
slot" is selected.

The structure of the selected slot (in the example, synchronization burst) is displayed in
the dialog header. The individual fields of the burst are color-coded.

The available marker signals are also color-coded. In the left "Configure Control Sig-
nal" section, each individual signal is assigned a color. A check in the checkbox shows
the marker for which the "As defined in slot" marker type has been selected.

In the next section, "Select Ramp to Edit", the signal characteristics are graphically dis-
played.

The ramps can be assigned the exact bit position in the signal by

® The schematic display of the slot above the section.

® The bit scale below the marker/control signal characteristic.

® The display of the current cursor position in the "Cursor" dialog section if the cursor
marks the ramp. The field at the selected position in the slot is displayed on the
side. The bit position of the cursor within this field is displayed below

The ramps can be set either graphically in the "Select Ramp to Edit" section or in the
table of the "Positions Marker x" section. To make the setting easy, a selection of pre-
set ramp characteristics is offered in the "Preset Ramp Marker x" section.

Provided are the following settings:

Configure Control Signal
Displays the color the marker and the Burst Gate signal has been assigned.

Displays whether the "CList" marker mode has been selected for this marker signal,
see "Marker Settings".

Displays whether the "As defined in Slot" marker mode has been selected for this
marker signal.

The source can be selected here as well and is then used in the associated dialogs.
Note: The burst gate signal is only displayed and cannot be edited.

Remote command:
[ :SOURce<hw>] :BB:GSM|[ : FRAMe<di>] : SLOT<st(0>[ :USER<ch>] : TRIGger:
OUTPut:TAG? on page 102

Select Ramp to Edit
Graphically edit marker signals.

For this purpose, the cursor is set to the position where a ramp is required. The ramp is
generated by pressing Enter (e.qg. clicking the rotary knob). Any number of ramps can
be defined per marker. Each of the generated ramp positions is saved even if the defi-
nition of another ramp produces a low/low or high/high transition. The ramps are dis-
played as dashed lines.
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Existing ramps can be shifted after the cursor has been placed on the ramp and Enter
has been pressed — it then changes color twice. The ramp is shifted by using the cur-
sor keys or the rotary knob. The new position is determined by pressing Enter again.

Ramps can be deleted with the [BACKSPACE] key after the cursor has been placed on
the ramp.

Remote command:
n.a.

Total List Length
Displays the length of the list in bits.

Remote command:
n.a.

Preset Type
Activates presetting for the ramp characteristic of the selected control signal. The pre-
setting is selected with select "Preset Type" and activated with the "Preset" button.

You can select from:

"All Up" The marker signal is continuously high.

"All Down" The marker signal is continuously low.

"Ramp Up" The marker signal contains a ramp from low to high. The ramp is shif-
ted to the center of the displayed signal area and can then be shifted
as required.

"Ramp Down" The marker signal contains a ramp from high to low. The ramp is shif-
ted to the center of the displayed signal area and can then be shifted

as required.
"Ramp Up/ The marker signal contains a ramp from low to high and from high to
Down" low. The ramps are symmetrically shifted around the center of the dis-
played signal area and can then be shifted as required.
"Ramp The marker signal contains a ramp from high to low and from low to
Down/Up" high. The ramps are symmetrically shifted around the center of the

displayed signal area and can then be shifted as required.

Remote command:
n.a.

Edit Table
Opens table by using the "Edit Table" button.

The ramps of the selected signal can be edited in the table. When the table is opened,
the current configuration of the selected marker/control signal is displayed.
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GSM (F1:50) Positions - Marker 1

Ramp Position Ramp State
0 Low
12 High
2_58 Low
b o High
I

The bit position is specified in the "Ramp Position" column, the high or low signal sta-
tus in the "Ramp State" column. At the end of the list, there is always a blank row for
entering new values.

The changes are accepted in the graphic display after pressing the "Accept" button.

Remote command:
n.a.

Cursor Position
Enters the cursor position.

In the graphic display, the cursor is positioned according to the entry.
Vice versa, graphically shifting the cursor changes the displayed value.

The field at the selected position in the slot is displayed on the side. The bit position of
the cursor within this field is displayed below.

Remote command:
n.a.

Zoom In/Visible
Zooms the displayed area of the control list. The designation of the button changes
from "Zoom in" to "Zoom out".

With long control lists, the displayed area can be zoomed around the current "Cursor
Position".

Parameter "Visible/Bits Visible" determines the number of symbols/bits to be displayed.
Ramps outside the displayed area are not lost by zooming.

Remote command:
n.a.
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Save

Saves the settings made in the "Slot Marker" dialog into a file with filename format
GsmMarkSlotDefP<x>F<y>S<z>U<w>.dm igc, where:

® x the path number,

® v is the Frame number,

® 7 is the Slot number and

® yisthe User number.

Remote command:
n.a.
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4 Remote-control commands

The following commands are required to perform signal generation with the GSM/
EDGE options in a remote environment. We assume that the R&S SMM100A has
already been set up for remote operation in a network as described in the

R&S SMM100A documentation. A knowledge about the remote control operation and
the SCPI command syntax are assumed.

@ Conventions used in SCPl command descriptions

For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMM100A user manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> 1 available baseband signals

OUTPut<ch> 1t03 available markers

FRAMe<di> [1]]12 ® in Frame (Double) mode (SOURce : BB: GSM: MODE

DOUBLe) this suffix defines the frame to which the
setting applies

® in Frame (Single) mode the keyword FRAMe is
ignored and can be omitted

SLOT<st0> o[11..7 defines the slot to which the setting applies

Note: SCPI prescribes that suffix 1 is the default state and
used when no specific suffix is specified. Therefore, slot 1
(and not slot 0) is selected when no suffix is specified.

SUBChannel<us> [11]12 defines the VAMOS subchannel

USER<ch> [1]12 defines the half rate user in a half rate mode

The following commands specific to the GSM/EDGE are described here:

L CTCT o 1Y = | I oTe) T3 0 F= T T 63
o Save/recall frame/slots COMMANAS.......c.ooevuueiiiiiieee e e eeaaas 69
o  Modulation/filter COMMANGS...........oeiiieeeire e 74
®  ClOCK COMMANAS......ooiiiii et e et e e e e e et e e e e e eeaba s e eeeenenan 81
L I oo =Y aoTo] a1 F=T o Lo 70U 82
@ Marker COMMEANGS........covuiieiiieteee ettt e e e ettt e e e e e et e e e e eeeta e e e s eeesanaeeaes 87
e Power ramping/slot attenuation commands............ccoccciiii e 89
o Burst editor COMMANAS........cooneieeee e 91
e Slot marker definition COMMANAS..........covvuiiiiiiiee e 102
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General commands

4.1 General commands

[:SOURCe<hW>]:BB:GSM:SLENGN. ..ceiiiiiiiiititeeeeae et 63
[:SOURCE<hW>]:BB:GSMiFLENGtN....cciiiiieiiiieeeeieieeeeeeeeeeerete s eese s e e e e e eeeeeeeeeeeeereeesesanes 63
[:SOURCE<hW>]:BB:GSIM:FONE.......ccitttiiiieeieeiiiie e eee et e e e e eetee e e e e e eebe s e e e e eetane e e e e eentanaanns 64
[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPEtItiONS.......coeeeiiiiiiieeeeeieitee e 64
[:SOURCe<hw>]:BB:GSM:ISLENGN.....cenieiei et et e e e 64
[:SOURCe<hW>]:BB:GSM:iMODE...... .ottt et et e e e e e e e e e e e eaeennean 65
[:SOURCE<hW>]:BB:GSM:PRESEL......ciiiiieituieieeeeiiee i e e e eeeiee s e e e et e e e e e eetae e e e eeenanneaeeenennas 65
[:SOURCce<hw>]:BB:GSM:SATTENUAtIONKCN>......uiiiiieiee e e ee e 66
[:SOURCce<hw>]:BB:GSM:SETTING:CATAlOG?.......cteeeerrerrrererniiniaaaaeieseseeeeeaaaeseseeseeereeseesenes 66
[:SOURCce<hw>]:BB:GSM:SETTING:DELELE.....uciiieiiiiiiiee ettt eees 66
[:SOURce<hw>]:BB:GSM:SETTING:LOAD. ...ttt et e e 67
[:SOURce<hw>]:BB:GSM:SETTING:STORE.....ceuiiiiiieeiii ettt et e e e 67
[:SOURCe<hW>]:BB:GSM:SMODAE......ccuiiiiiieieeee et e e e e e e et e e e ee e eaneanas 67
[:SOURCE<hW>]:BB:GSM:iSRATE. .....cceiieeeieeeeeeeeeeiieieite e e e e e e e e e e e eaaeaeaeeeeeeeeeeneenensnnnnnnnnn 68
[:SOURce<hw>]:BB:GSM:SRATE:IMODE..........ccceeieieieieieiieininnaaaaaaeaeeeesaeaaaeeeereeeeeeeeeannnnes 68
[[SOURCESNWS | BB G SIM:STATE. ..etuuiieeeeetteeeeeeeetttiaeeeeeettaaeeeeeeetttasaeeeestaaeeaessssnnaaaeeeesnns 69
[:SOURce<hw>]:BB:GSM:WAVEfOrM:CREALE........cceeeieiiiieieeeeeeiiee e et e e e e et e e eebae s 69

[:SOURce<hw>]:BB:GSM:SLENgth <SLength>
[:SOURce<hw>]:BB:GSM:FLENgth <FLength>

Sets the sequence length of the generated arbitrary waveform file in number of frames.
This parameter applies to GSM modes Single or Double framed.

For GSM mode Framed Double, this command is query only, since the length of the
generated ARB file is determined by the parameter Frame Repetition (| :
SOURce<hw>] :BB:GSM: FRAMe<di>:REPetitions) for both frames:

Sequence Length = Frame Repetition of Frame 1 + Frame Repetition of Frame 2.

For GSM mode (BB : GSM: MODE) set to Unframed, the length of the generated ARB file
is set in symbols with the command [ : SOURce<hw>] : BB:GSM: SLENgth.

Parameters:
<FLength> integer

Range: 1 to max
Example: BB:GSM:MODE SING

Selects framed single GSM mode.
BB:GSM:FLEN 2

Sets the sequence length to two frames.
BB:GSM:MODE DOUB

Selects framed double GSM mode.
BB:GSM:FRAM1 :REP 2

Sets the frame repetition of frame 1 to 2.
BB:GSM: FRAM2:REP 1

Sets the frame repetition of frame 2 to 1.
BB:GSM:FLEN?

Queries the sequence length.
Response: 3
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General commands

Manual operation: See "Sequence Length ARB" on page 41

[:SOURce<hw>]:BB:GSM:FONE <FOne>

A modulating bit stream consisting of consecutive ones is used for inactive slots
(according to GSM 05.04).

If this parameter is disabled, the inactive slots are filled in with 0.

Parameters:

<FOne> 1|ON |0 | OFF
*RST: OFF

Example: BB:GSM:FONE ON

A modulating bit stream consisting of consecutive ones is used
for inactive slots.

Manual operation: See "Force Dummy Bits to 1" on page 33

[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPetitions <Repetitions>

The command defines the number of repetitions for the selected frame in GSM mode
Frame (Double).

Parameters:
<Repetitions> integer
Range: 1 to 500000
*RST: 1/1
Example: BB:GSM:MODE DOUB

selects GSM mode Frame (Double).
BB:GSM:FRAM2 :REP 10

sets 10 repetitions for frame 2.

Manual operation: See "Frame Repetition" on page 30

[:SOURce<hw>]:BB:GSM:ISLength <ISLength>
Selects constant slot length.

Parameters:

<ISLength> 1]ON| 0| OFF
For normal symbol rate mode:
The command selects whether the 1/4 symbol of a GSM slot is
ignored or compensated for by an extra symbol every 4th slot.
For higher symbol rate mode:
The command selects whether the 1/2 symbol of an average slot
with a length of 187.5 symbols are ignored or compensated for
by an extra symbol every second slot.
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General commands

ON
In normal symbol rate mode, all slots are 156 symbols long
In higher symbol rate mode, all slots are 187 symbols long

OFF
In normal symbol rate mode, some slots are 157 symbols long
In higher symbol rate mode, some slots are 188 symbols long

*RST: 0

Example: BB:GSM: SRAT:MODE NSR
Selects normal symbol rate mode.
BB:GSM:ISL ON

Selects a constant length of 156 symbols for all slots.

Manual operation:  See "Ignore 1/4 symbol (slot length 156 sym) / Ignore 2 symbol
(slot length 187 sym)" on page 33

[:SOURce<hw>]:BB:GSM:MODE <Mode>

The command selects GSM mode.

Parameters:
<Mode> UNFRamed | SINGle | DOUBIe | MULTiframe
UNFRamed
Modulation signal without slot and frame structure.
SINGle
Modulation signal consisting of one frame.
DOUBIe
Modulation signal in which two frames are defined and then
combined by some method into a single multiframe signal.
MULTiframe
Multiframe signal.
*RST: SINGle
Example: BB:GSM:MODE SING

sets the "Single Frame" GSM mode. Only the commands for
defining a single frame are valid.

Manual operation: See "Sequence Mode" on page 16

[:SOURce<hw>]:BB:GSM:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:GSM: STATe.
Example: SOURcel :BB:GSM: PRESet
Usage: Event

Manual operation: See "Set to Default” on page 15
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General commands

[:SOURce<hw>]:BB:GSM:SATTenuation<ch> <SAttenuation>

The command sets up to seven different values for level attenuation. The various val-
ues are defined by the suffix to SATTenuation. These values are used when defining
the level attenuation of individual slots with the aid of the command [ : SOURce<hw>] :
BB:GSM][ : FRAMe<di>] : SLOT<st0>[:SUBChannel<us>] [ :USER<ch>]:

ATTenuation.

Parameters:

<SAttenuation> float
Range: 0 to 70
Increment: 0.1
*RST: 0
Default unit: dB

Example: BB:GSM:MODE SING

Selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT

Sets level attenuation mode for slot 1.
BB:GSM:SATT1 12

Sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT Al

Sets the level attenuation for slot A1 to 12 dB.

Manual operation: See "Slot Attenuation A1 to A7" on page 44

[:SOURce<hw>]:BB:GSM:SETTing:CATalog?

This command reads out the files with GSM settings in the default directory. The
default directory is set using command MMEM: CDIRectory. Only files with the file
extension * . gsm are listed.

Return values:
<Catalog> string

Example: MMEM:CDIR "/var/user/temp/dig mod
Sets the default directory to /var/user/temp/dig_mod.
BB:GSM:SETT:CAT?
Reads out all the files with GSM settings in the default directory.
Response: gsm 1

Usage: Query only

Manual operation: See "Save/Recall" on page 16

[:SOURce<hw>]:BB:GSM:SETTing:DELete <Filename>

This command deletes the selected file with GSM settings. The directory is set using
command MMEM: CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension can be omitted. Only files with the
file extension * . gsm are deleted.
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General commands

Setting parameters:
<Filename> string

Example: BB:GSM:SETT:DEL 'gsm 1'
Deletes file gsm 1.

Usage: Setting only

Manual operation: See "Save/Recall" on page 16

[:SOURce<hw>]:BB:GSM:SETTing:LOAD <Filename>

This command loads the selected file with GSM settings. The directory is set using
command MMEM: CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension can be omitted. Only files with the
file extension * . gsm are loaded.

Setting parameters:
<Filename> string

Example: BB:GSM:SETT:LOAD 'gsm 1'
Loads file gsm 1

Usage: Setting only

Manual operation: See "Save/Recall" on page 16

[:SOURce<hw>]:BB:GSM:SETTing:STORe <Filename>

This command stores the current GSM settings into the selected file. The directory is

set using command MMEM: CDIRectory. A path can also be specified, in which case

the files in the specified directory are read. Only enter the file name. GSM settings are
stored as files with the specific file extensions * . gsm.

Setting parameters:
<Filename> string

Example: BB:GSM:SETT:STOR 'gsm 1'
Stores the current GSM settings into file gsm_1.

Usage: Setting only

Manual operation: See "Save/Recall" on page 16

[:SOURce<hw>]:BB:GSM:SMODe <SMode>

Selects the modulation signal for the mode Unframed (: BB: GSM:MODE UNFR). The
modulation type and filter type are set in accordance with the selection.

The available simulation modes depend on the selected symbol rate:
® Normal Symbol Rate - GSM, EDGE (8PSK), AQPSK, 16QAM and 32QAM
® Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.
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General commands

Note:"Higher Symbol Rate" Mode and "Simulation Modes" AQPSK, 16QAM, 32QAM,
HSR QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped
with option R&S SMM-K41 only.

Parameters:
<SMode>

Example:

Options:

Manual operation:

GSM | EDGE | N16Qam | N32Qam | HQPSk | H16Qam |
H32Qam | AQPSk

*RST: GSM

BB:GSM:MODE UNFR

Sets unframed mode.

BB:GSM: SRAT:MODE HSR

Selects higher symbol rate mode.

BB:GSM:SMOD H16Q

Selects an HSR 16QAM modulation signal for the Unframed
mode.

BB:GSM: SRAT :MODE NSR

Selects normal symbol rate mode.
BB:GSM:SMOD GSM

Selects a GSM modulation signal for the Unframed mode.

R&S SMM-K41 (required for N16Qam | N32Qam | HQPSK |
H16Qam | H32Qam | AQPSk)

See "Simulation Mode" on page 16

[:SOURce<hw>]:BB:GSM:SRATe <SRate>

Sets the symbol clock. Possible units are Hz, kHz, MHz, Sym/s, kSym/s, MSym/s.

Parameters:
<SRate>

Example:

Manual operation:

float

Range: 400 to 15000000
Increment: 0.001
*RST: 270.833 kSym/s

BB:GSM:SRAT 270.9 kHz
sets the symbol clock to 270.9 kHz.

See "Symbol Rate" on page 33

[:SOURce<hw>]:BB:GSM:SRATe:MODE <Mode>

Set the symbol rate mode, i.e. determines whether normal bursts (NB) or higher sym-
bol rate bursts (HB) are generated.

Parameters:
<Mode>

User Manual 1179.2048.02 — 05

NSRate | HSRate
*RST: NSRate
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4.2

Save/recall frame/slots commands

Example: BB:GSM:SRAT HSR
Selects higher symbol rate mode
BB:GSM: SRAT?
Queries the symbol clock.
Response: 325

Options: (for instruments equipped with option K41 only)

Manual operation: See "Symbol Rate Mode" on page 16

[:SOURce<hw>]:BB:GSM:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 1|ON |0 | OFF
*RST: 0
Example: SOURcel :BB:GSM: STATe ON

Manual operation: See "State" on page 14

[:SOURce<hw>]:BB:GSM:WAVeform:CREate <Filename>

Creates a waveform using the current settings of GSM/EDGE. The file name is entered
with the command. The file is stored with the predefined file extension * .wv. The file
name and the directory it is stored in are user-definable.

Setting parameters:
<Filename> string

Example: MMEM:CDIR '/var/user/temp/waveform'
sets the default directory to /var/user/temp/waveform.
BB:GSM:WAV:CRE 'gsm 1'
creates the waveform file gsm.wv in the default directory.

Usage: Setting only

Manual operation: See "Generate Waveform File..." on page 16

Save/recall frame/slots commands

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATAIOg?. .. uuieeeereerii e it eereen e e eeeennns 70
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELEte....cc.uueiiiiiiiiiiiieeieete e 70
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD.....cccieeiiieei e eee e e e e 71
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:STORE.....ccctruiieiini et eee e 71
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATaIOg?.......cceeeeeeeeereeeeeeeeeeeneninnnnnnnnns 71
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD......ccctviieiiiiiiiieicic e 72
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:
PREDEfINE:CATAIOG?. ..cieieeeieieiiititeeeeeeaae i e e e eeeeeeaeeeeeeeeeeeeeeeersta b e s e aeeeaaaaaaans 72
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Save/recall frame/slots commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:

PREDEfINEA:LOAD. ...ttt ettt e ettt e e e e e et e e e e e eeba e e e eeeenna e eeaeees 72
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:
(]S} o 07N - 1o 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:
ULIStDELEE. ceettieieeeeieeiiet ettt e ettt e e et e e e e e e st e e e e e e e e e e e e e s annbrnaeeeeaeas 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:
ULISELOAD. .. ettt ettt ettt e e e ettt e e e e et s e e e e ee e e e eeeenna e e eerenbnn e aaaes 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:
L] o0 T 74

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATalog?

This command reads out the files with user defined frame settings in the default direc-
tory. The default directory is set using command MMEM: CDIRectory. Only files with
the file extension *.gsm fu and *.gsm_hfu are listed.

Return values:
<Catalog> string

Example: MMEM:CDIR "/var/user/temp/frames"
Sets the default directory to /var/user/temp/frames.
BB:GSM:FRAM:ULIS:CAT?
Reads out all the files with user defined frame settings in the
default directory.
Response: 'NB all'
The file NB_al1l with a user defined frame setting is available.

Usage: Query only

Manual operation: See "Recall User Files" on page 31

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELete <Filename>

This command deletes the selected file with user defined frame settings. The directory
is set using command MMEM: CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. The file extension can be omitted.
Only files with the file extension *.gsm fu and *.gsm hfu are deleted.

Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:DEL 'NB all'
Deletes fle NB_all.

Usage: Setting only

Manual operation: See "File Manager" on page 31
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Save/recall frame/slots commands

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD <Filename>

This command loads the selected file with user defined frame settings. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension can be omitted. Only files
with the file extension *.gsm fu and *.gsm_hfu are loaded.

Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:LOAD 'NB all'
Loads file NB all.

Usage: Setting only

Manual operation: See "Recall User Files" on page 31

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:STORe <Filename>

This command stores the current frame settings into the selected file. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. Only enter the file name. User Standards
are stored as files with the specific file extensions *.gsm_ fu and *.gsm_hfu.

Setting parameters:
<Filename> string

Example: BB:GSM:FRAM:ULIS:STOR 'EDGE all'
Stores the current frame settings into file EDGE_all.

Usage: Setting only

Manual operation: See "Save User Files" on page 31

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATalog?

This command reads out the files with predefined frame settings. The directory is pre-
set, therefore a path cannot be specified.

Return values:
<Catalog> string

Example: BB:GSM: FRAM: PRED:CAT?
reads out all the files with predefined frame settings.
Response: 'EdgeO, EdgeAll, GsmEdge,
NormalBurst0O, NormalBurstAll'
the file names of the files with the predefined frame settings are
returned

Usage: Query only

Manual operation: See "Recall Predefined Files" on page 30
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Save/recall frame/slots commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined frame settings. The directory is
pre-set, therefore a path cannot be specified.

Setting parameters:
<Filename> string

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SRAT:MODE NSR
selects normal symbol rate.
BB:GSM:FRAM: PRED:LOAD 'EdgeO'

loads file Edge0 with the predefined frame setting Edge Burst in
Slot 0.

Usage: Setting only

Manual operation: See "Recall Predefined Files" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:CATalog?

This command reads out the files with predefined slot settings. The directory is preset,
therefore a path cannot be specified.

The numeric suffixes in all key words are irrelevant for this command.

Return values:
<Catalog> string

Example: BB:GSM:SLOT: PRED:CAT?
reads out all the files with predefined frame settings.
Response: GSM NB PNY9 TSCO,EDGE NB PN9 TSCO
the files GSM_NB PN9 TSCO and EDGE_NB PN9 TSCO are
available.

Usage: Query only

Manual operation: See "Recall Predefined Files" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined slot settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:PRED:LOAD 'GSM NB PN9 TSCO'
loads the settings of file GSM_NB PN9 TscO for slot 1 in frame
1.

Usage: Setting only
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Save/recall frame/slots commands

Manual operation: See "Recall Predefined Files" on page 30

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:CATalog?

This command reads out the files with user defined slot settings in the default directory.
The default directory is set using command MMEM: CDIRectory. Only files with the file
extension *.gsm_sluand *.gsm hslu are listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '/var/user/temp/slots
Sets the default directory to /var/user/temp/slots.
BB:GSM:SLOT:ULIS:CAT?
Reads out all the files with user defined slot settings in the
default directory.
Response: 'test 01'

The file test 01 with a user defined slot setting is available.
Usage: Query only

Manual operation: See "Recall User Files" on page 31

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:DELete <Filename>

This command deletes the selected file with user defined slot settings. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension can be omitted. Only files
with the file extension *.gsm sluand *.gsm hslu are deleted.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:ULIS:DEL 'NB'
Deletes file NB.

Usage: Setting only

Manual operation: See "File Manager" on page 31

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:LOAD <Filename>

This command loads the selected file with user defined slot settings. The directory is
set using command MMEM: CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension can be omitted. Only files
with the file extension *.gsm sluand *.gsm hslu are loaded.

Setting parameters:
<Filename> string
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4.3

4.3.1

Modulation/filter commands

Example: BB:GSM:SLOT:ULIS:LOAD 'NB'
Loads file NB.

Usage: Setting only

Manual operation: See "Recall User Files" on page 31

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:STORe <Filename>

This command stores the current slot settings into the selected file. The directory is set
using command MMEM: CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only enter the file name. User slots are stored
as files with the specific file extensions *.gsm _sluand *.gsm hslu.

Setting parameters:
<Filename> string

Example: BB:GSM:SLOT:ULIS:STOR 'EDGE'
Stores the current slot settings into file EDGE.

Usage: Setting only

Manual operation: See "Save User Files" on page 31

Modulation/filter commands

Modulation commands

[:SOURCe<hW>]:BB:GSM:FORMEL.....cccceeeuriieeeeieeiiiieeeeeeeetiieeeeeeeettaeseeeerstaaeeeeseennaseeesensnns 74
[:SOURCce<hw>]:BB:GSM:EDGE:FORMAL?......cceieeiitrieieeeieiiiiieeeeeetetieeeeeseeraaeeeeeeesnanaeaesenes 75
[:SOURce<hw>]:BB:GSM:FSK:DEVIation.....ccciiuiiiiiiii e et e e 75
[:SOURce<hw>]:BB:GSM:AQPSK:FORMAL?. ... .ot et e e e eans 75
[:SOURce<hw>]:BB:GSM:H16Qam:FORMAL?......c.cieieiii i e e e e 76
[:SOURce<hw>]:BB:GSM:H32Qam:FORMAL?........uuuuuaaaaaaaeeeeeeeeeeeeeeeeeeeeeeeeeeeeanenneee e e 76
[:SOURCce<hw>]:BB:GSM:HQPSK:FORMAL?.......ceiieeiiiiiiieeeeeeiieee e eeeeete e e e e e e eane e e e e eeannnaeea e 77
[:SOURce<hw>]:BB:GSM:N16Qam:FORMAL?.........uceereeriirieieeeeeiiiieeeeeerereieeeeeeraneeeeeeenranns 77
[:SOURce<hw>]:BB:GSM:N32Qam:FORMAL?......ccuuuieiieriirieieeeeeiinieeeeeeeeieseeeeeesnnneeeeeeennnns 77
[:SOURce<hw>]:BB:GSM:AQPSK:ANGLESChO>......ciuiiiiieiiii e 78
[:SOURce<hw>]:BB:GSM:AQPSK:SCPIR<CNO>... ettt e e e 78

[:SOURce<hw>]:BB:GSM:FORMat <Format>
The command selects the modulation type.

Parameters:
<Format> MSK | FSK2

*RST: MSK
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Modulation/filter commands

Example: BB:GSM:FORM FSK2
selects the GSM modulation type FSK.

Manual operation: See "Modulation" on page 34

[:SOURce<hw>]:BB:GSM:EDGE:FORMat?

The command queries the modulation type in the case of EDGE. The modulation type
is permanently set to 8PSK.

Return values:

<Format> P8EDge
*RST: P8EDge
Example: BB:GSM:EDGE : FORM?

queries the modulation type.
Response: "PSED"

Usage: Query only
Manual operation: See "Modulation Type EDGE" on page 36

[:SOURce<hw>]:BB:GSM:FSK:DEViation <Deviation>
Sets the modulation deviation when :BB:GSM: FORMat FSK?2 is selected.

The range of values depends on the symbol rate (: BB: GSM: SRATe). The maximum
deviation is 10 MHz.

Parameters:
<Deviation> float
Range: 0.1xf(symb) to 1.5xf(symb);(10MHz)
Increment: 0.1
*RST: 67708.3333
Default unit: Hz
Example: BB:GSM:FORM FSK2

selects the GSM modulation type GFSK.
BB:GSM:FSK:DEV 37.6 kHz

sets the FSK deviation to 37.6 kHz.

Manual operation: See "FSK Deviation" on page 34

[:SOURce<hw>]:BB:GSM:AQPSk:FORMat?

The command queries the modulation type. The modulation type is permanently set to

AQPSK.
Return values:
<Format> AQPSKk
*RST: AQPSk
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Remote-control commands

Example:

Usage:
Options:

Manual operation:

Modulation/filter commands

BB:GSM:AQPS:FORM?
queries the modulation type.
Response: "AQPSk"

Query only
R&S SMM-K41
See "Modulation AQPSK" on page 35

[:SOURce<hw>]:BB:GSM:H16Qam:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:

Usage:

Options:

Manual operation:

QAM16EDge
*RST: QAM16EDge

BB:GSM: SRAT :MODE HSR
selects higher symbol rate mode.
BB:GSM:H16Q:FORM?

queries the modulation type.
Response: "QAM16ED"

Query only

(for Higher Symbol Rate and instruments equipped with option
K41 only)

See "Modulation Type HSR 16QAM" on page 40

[:SOURce<hw>]:BB:GSM:H32Qam:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:

Usage:

Options:

Manual operation:
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QAM32EDge
*RST: QAM32EDge

BB:GSM: SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:H32Q:FORM?

queries the modulation type.
Response: QAM32ED

Query only

(for Higher Symbol Rate and instruments equipped with option
K41 only)

See "Modulation Type HSR 32QAM" on page 40
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Modulation/filter commands

[:SOURce<hw>]:BB:GSM:HQPSk:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:

Usage:

Options:

Manual operation:

QEDGe

*RST: QEDGe
BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM: HQPS : FORM?

queries the modulation type.
Response: Q0ODG

Query only

(for Higher Symbol Rate and instruments equipped with option
K41 only)

See "Modulation Type HSR QPSK" on page 39

[:SOURce<hw>]:BB:GSM:N16Qam:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:

Usage:
Options:

Manual operation:

QAM16EDge
*RST: QAM16EDge

BB:GSM: SRAT :MODE NSR
selects normal symbol rate mode.
BB:GSM:N16Q:FORM?

queries the modulation type.
Response: QAM16GED

Query only
(for instruments equipped with option K41 only)

See "Modulation Type 16QAM" on page 37

[:SOURce<hw>]:BB:GSM:N32Qam:FORMat?

The command queries the modulation type.

Return values:
<Format>

Example:
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QAM32EDge
*RST: QAM32EDge

BB:GSM: SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:N32Q:FORM?

queries the modulation type.
Response: QAM32ED

77



R&S®SMM-K40/-K41 Remote-control commands

4.3.2

Modulation/filter commands

Usage: Query only
Options: (for instruments equipped with option K41 only)

Manual operation: See "Modulation Type 32QAM" on page 38

[:SOURce<hw>]:BB:GSM:AQPSk:ANGLe<ch0> <Angle>
Sets the angle alpha.

Parameters:
<Angle> float
Range: 0.0001 to 89.9999
Increment: 0.0001
*RST: 45
Example: BB:GSM:AQPS:ANGL5 50
Options: R&S SMM-K41

Manual operation: See "Angle alpha 0 ... alpha_7" on page 35

[:SOURce<hw>]:BB:GSM:AQPSk:SCPIR<ch0> <Scpir>

Sets the Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle a as
follows:

SCPIR = 20 * log,(tan a) dB,
where the value of a is chosen such that |[SCPIR|<10dB.

Parameters:

<Scpir> float
Range: -115.1625 to 115.1625
Increment: 0.0001
*RST: 0

Exan“ﬂe: BB:GSM:AQPS:SCPIR5 -10

BB:GSM:AQPS:ANGL5?
Response: 17.5484

Options: R&S SMM-K41
Manual operation: See "SCPIR_0 to SCPIR_7" on page 36

Filter commands

[:SOURCE<hW>]:BB:GSM:FILTErTYPE?. . i ieitieeieeeeeeteeee et eetee e e e e e eetae e e e s eerateeeeeseenanseeeeees 79
[:SOURCe<hw>]:BB:GSM:FILTEr:PARAMELEN.......uuceieeeieireieeeeeeiieee e e e ettt e e e e e eeabee e e e s eerananns 79
[:SOURce<hw>]:BB:GSM:FILTer:AQPSK:TYPE . ...t e e e 79
[:SOURce<hw>]:BB:GSM:FILTEer:EDGE:TYPE?. ..o e e 80
[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?....ccccoiiiieeie e 80
[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE?....ccccceeeeeieieeeeeeeeeeeeeeeeeete e 80
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Modulation/filter commands

[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE. ... ... et 80
[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE.... ...t 81
[:SOURce<hw>]:BB:GSM:FILTer:HQPSK:TYPE. ....ccceie e e e e ee ettt e e e 81

[:SOURce<hw>]:BB:GSM:FILTer:TYPE?

The command sets the filter type GAUSSs. This is the only possible selection in the
case of digital standard GSM.

Return values:

<Type> GAUSs
*RST: GAUSs
Example: BB:GSM:FILT:TYPE GAUS

sets the filter type GAUSS.
Usage: Query only

Manual operation: See "Filter" on page 34

[:SOURce<hw>]:BB:GSM:FILTer:PARameter <Parameter>

The command sets the filter parameter. For Gaussian filter the BxT is the product of
the bandwidth and the symbol duration. The default value for GSM modulation is 0.3
and for Gauss Linearized (EDGE), BT = 0.3.

Parameters:
<Parameter> float
Range: 0.15 to 2.5
Increment: 0.01
*RST: 0.3
Example: BB:GSM:FILT:PAR 0.4

sets the BT value to 0.4.

Manual operation: See "Filter Parameter" on page 35

[:SOURce<hw>]:BB:GSM:FILTer:AQPSK:TYPE?

Queries the filter type for AQPSK modulation. The filter is permanently set to GAUSS
linearized.

Return values:

<Type> LGAuss

*RST: LGAuss
Usage: Query only
Options: R&S SMM-K41

Manual operation: See "Filter" on page 36
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Modulation/filter commands

[:SOURce<hw>]:BB:GSM:FILTer:EDGE:TYPE?

The command sets the filter type LGAuss. This is the only possible selection in the
case of digital standard GSM EDGE.

Return values:

<Type> LGAuss
*RST: LGAuss
Example: BB:GSM:FILT:EDGE: TYPE LGA

sets the filter type Gauss linearized.
Usage: Query only

Manual operation: See "Filter" on page 37

[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?
Queries filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

Return values:
<Type> LGAuss

Example: BB:GSM:FILT:N16Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only
Options: K41

Manual operation: See "Filter" on page 37

[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE?
Queries filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

Return values:
<Type> LGAuss

Example: BB:GSM:FILT:N32Q:TYPE?

queries the filter type.
Response: LGA

Usage: Query only
Options: K41

Manual operation: See "Filter" on page 38

[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE <Type>
Sets the filter for HSR 16QAM signal.
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4.4

Clock commands

Parameters:
<Type> ENPShape | EWPShape
*RST: ENPShape
Example: BB:GSM:FILT:H16Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE <Type>
Sets the filter for HSR 32QAM signal.

Parameters:
<Type> ENPShape | EWPShape
*RST: ENPShape
Example: BB:GSM:FILT:H32Q:TYPE ENPS

Manual operation: See "Filter" on page 40
See "Filter" on page 40

[:SOURce<hw>]:BB:GSM:FILTer:HQPSk:TYPE <Type>
Sets the filter for HSR QPSK signal.

Parameters:
<Type> ENPShape | EWPShape
*RST: ENPShape
Example: BB:GSM:FILT:HQPS:TYPE ENPS

Manual operation: See "Filter" on page 39

Clock commands

This section lists the remote control commands, necessary to configure the clock.

[:SOURce<hw>]:BB:GSM:CLOCK:SOURCE......uuuuueiiieieieeeeeeeeeeeeeeeeeeeeeeeeeneeinsnnnnaannneneeeeeeas 81

[:SOURce<hw>]:BB:GSM:CLOCk:SOURce <Source>

Selects the clock source:
® TINTernal: Internal clock reference
® TFICLock: External local clock

® FEXTernal = ELCLock: Setting only
Provided for backward compatibility with other Rohde & Schwarz signal generators

Parameters:
<Source> INTernal
*RST: INTernal
Example: SOURcel :BB:GSM:CLOCk:SOURce INT
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4.5

Trigger commands

Manual operation: See "Clock Source" on page 25

Trigger commands

Example: Trigger configuration

SOURcel:BB:GSM: TRIGger:SOURce INTernal
SOURcel:BB:GSM:TRIGger:SEQuence ARETrigger
SOURcel:BB:GSM:STAT ON

SOURcel:BB:GSM: TRIGger:EXECute
SOURcel:BB:GSM: TRIGger :ARM: EXECute
SOURcel:BB:GSM: TRIGger :RMODe?

// stopped

SOURcel:BB:GSM: TRIGger:EXECute
SOURcel:BB:GSM: TRIGger :RMODe?

// run

// SOURcel:BB:GSM:TRIGger:SEQuence SING
// SOURcel:BB:GSM:TRIGger:SLUNit FRAMe
// SOURcel:BB:GSM:TRIGger:SLENgth 2

// SOURcel:BB:GSM:TRIGger:SEQuence ARET

// SOURcel:BB:GSM:TRIGger:SOURce EGT1

// SOURcel:BB:GSM:TRIGger:EXTernal:SYNChronize:0OUTPut 1
// SOURcel:BB:GSM:TRIGger:EXTernal:INHibit 100

// SOURcel:BB:GSM:TRIGger:EXTernal:DELay 10

[:SOURce<hw>]:BB:GSM[:TRIGQEI:SEQUENCE......cevurueieeieeiriieeeeeeeiiaeeeeeeeeinaeeeeeeeennaeaaeens 82
[:SOURce<hw>]:BB:GSM:TRIGErARM:EXECULE.....ccuuuiiieeeeieiieieeceeieee e e e eeetee e e e eeeanae e 83
[:SOURce<hw>]:BB:GSM:TRIGGENEXECULE. .. .. uuaiaaeieieeeeeeeeeeeeeeeeeeeeeeeeeeeeinnesane e e e 83
[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPUL.......cccereeeereiieceniinineenenn. 83
[:SOURCce<hw>]:BB:GSM:TRIGGENRMODE?......ccceeetieieeeeeeeeceeeeeeeetee e e e e e e e e e e e eera e e eaeeeees 83
[:SOURCE<hW>]:BB:GSM: TRIGGEFSLENGN. c.. v eeeeeeeeeeeee s seseeeseeeeeeeeeeeeseseseseseseseseseseees 84
[:SOURce<hw>]:BB:GSM:TRIGGErSLUNIL.....cuiiiiiieiiee et e e e e e eeas 84
[:SOURce<hw>]:BB:GSM:TRIGGErSOURCE. ......iitiiiiiiii ettt 84
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal]:DELay......c.coueuriiriiiiiieiiiii e 85
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernall:INHibit..........ccceeumiiiiiiiiieeeeeee e 85
[:SOURCce<hw>]:BB:GSM:TRIGQErTIME:DATE.....ccieeiieiieieeeeeeiiee e ee et e e e et e e e e eeaaa s 85
[:SOURCce<hw>]:BB:GSM:TRIGGENTIME:TIME.....ccciieiiiiiieieeeeeeiiee e e et e e e eerae e e e e eer s 86
[:SOURce<hw>]:BB:GSM:TRIGGErTIME[:STATE]....utitieeeeeie ettt e e e e e e 86

[:SOURce<hw>]:BB:GSM[:TRIGger]:SEQuence <Sequence>
Selects the trigger mode:

® AUTO = auto

® RETRigger = retrigger

® AAUTo = armed auto
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Trigger commands

® ARETrigger = armed retrigger

® SINGle =single

Parameters:

<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle
*RST: AUTO

Example: See Example"Trigger configuration" on page 82

Manual operation: See "Mode" on page 18

[:SOURce<hw>]:BB:GSM:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.
Example: See Example"Trigger configuration" on page 82
Usage: Event

Manual operation: See "Arm" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:EXECute

Executes a trigger.

Example: See Example"Trigger configuration" on page 82
Usage: Event

Manual operation: See "Execute Trigger" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1]ON| 0| OFF
*RST: 1
Example: See Example"Trigger configuration" on page 82

Manual operation: See "Sync. Output to External Trigger/Sync. Output to Trigger"
on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:RMODe?
Queries the signal generation status.

Return values:

<RMode> STOP | RUN
Example: See Example"Trigger configuration" on page 82
Usage: Query only
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Trigger commands

Manual operation: See "Running/Stopped" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SING1e trigger mode.

Parameters:
<SLength> integer
Range: 1 to max
*RST: 1
Example: See Example"Trigger configuration" on page 82

Manual operation: See "Signal Duration" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:SLUNit <SLunit>

Defines the unit for the entry of the signal sequence length.

Parameters:
<SLunit> FRAMe | SYMBol
*RST: FRAMe
Example: See Example"Trigger configuration" on page 82

Manual operation: See "Signal Duration Unit" on page 19

[:SOURce<hw>]:BB:GSM:TRIGger:SOURce <Source>
Selects the trigger signal source and determines the way the triggering is executed.
Provided are:
® Internal triggering by a command (INTernal)
® External trigger signal via one of the local or global connectors
— EGT1|EGT2: External global trigger
— EGC1|EGC2: External global clock

® |n primary-secondary instrument mode, the external baseband synchronization sig-
nal (BBSY)

® OBASeband|BEXTernal |EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators.
The R&S SMM100A accepts these values and maps them automatically as follows:
EXTernal = EGT1, BEXTernal = EGT2, OBASeband = INTA

Parameters:

<Source> INTernal|EGT1|EGT2|[EGC1|EGC2|EXTernal|BBSY
*RST: INTernal

Example: See Example"Trigger configuration" on page 82

Manual operation: See "Source" on page 20
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Trigger commands

[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal]:DELay <Delay>
Sets the trigger delay.

Parameters:
<Delay> float

Range: 0 to 2147483647
Increment: 0.01

*RST: 0

Default unit: samples

Example: See Example"Trigger configuration" on page 82.

Manual operation: See "External Delay/Trigger Delay" on page 22

[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the duration by which a restart is inhibited.

Parameters:
<Inhibit> integer
Range: 0 to 21.47*symbRate
*RST: 0
Example: See Example"Trigger configuration" on page 82.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 21

[:SOURce<hw>]:BB:GSM:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME: STATe

<Digstd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer
Range: 1980 to 9999
<Month> integer
Range: 1 to 12
<Day> integer
Range: 1 to 31
Example: See example "Configure a time-based trigger signal" in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 20
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Trigger commands

[:SOURce<hw>]:BB:GSM:TRIGger:TIME:TIME <Hour>, <Minute>, <Second>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME: STATe

<Digstd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer
Range: 0 to 23
<Minute> integer
Range: 0 to 59
<Second> integer
Range: 0 to 59
Example: See example "Configure a time-based trigger signal" in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Trigger Time" on page 20

[:SOURce<hw>]:BB:GSM:TRIGger:TIME[:STATe] <State>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMM100A triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME: TIME

<DigsStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<State> 1]/ON|0|OFF
*RST: 0
Example: See example "Configure a time-based trigger signal” in the sub-

chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMM100A user manual.

Manual operation: See "Time Based Trigger" on page 19
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Marker commands

4.6 Marker commands

Example: Marker configuration

SOURcel:BB:GSM:TRIGger:OUTPutl :MODE PULS

// sets a pulse marker

SOURcel:BB:GSM: TRIGger:0UTPutl:PULSe:DIVider 2
SOURcel:BB:GSM: TRIGger:0UTPutl:PULSe: FREQuency?

SOURcel:BB:GSM:TRIGger:OUTPutl:MODE PATTern
// sets a bit pattern marker

SOURcel:BB:GSM: TRIGger:OUTPutl:PATTern #H2,2

SOURcel:BB:GSM:TRIGger:0UTPutl:MODE RAT
SOURcel:BB:GSM:TRIGger:OUTPutl:ONTime 1
SOURcel:BB:GSM:TRIGger:OUTPutl:OFFTime 1
// defines the on/off ratio

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:MODE........ccccetiiieeeiiaaaaaeieeeeeeeeeeeeeeeeae 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:ONTIME...cceetrrrrmrmunuaaaaaan e eeeeeeeeaaaaeaeeeeaees 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt<Ch>:0OFFTiMe...c..cocevuiiriiiieeeee e e 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:PATTEM....ccceieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeaaes 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERIOd:SLOT......cccveeieiiiiriieeeeeeeeieeeeeeeens 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod[:FRAME].......cc.covtriiiiiiiiiiiiieiein, 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSE:DIVIder..........uuuuuuuuaaiiaiaiaeeeaeaaaaennn 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQUENCY]?.......ccerrrrrrrrrrrnrnnnnnnn. 89
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:DELAY......ccccttiaieeeeeeeeeaeaeeeeeeeeeeeeeeeeeieee 89

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:

<Mode> SDEF | FRAMe | SLOT | PULSe | PATTern | RATio
SDEF
As defined in slots
The marker defined in the burst editor is used.
*RST: FRAMe

Example: See Example"Marker configuration" on page 87

Manual operation: See "Mode" on page 23

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:0FFTime <OffTime>

Sets the duration during which the marker output is on or off.
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Parameters:
<OffTime> integer
Range: 1 to 16777215
*RST: 1
Example: See Example"Marker configuration" on page 87

Manual operation: See "Mode" on page 23

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PATTern <Pattern>, <BitCount>

Defines the bit pattern used to generate the marker signal.

Parameters:
<Pattern> numeric
*RST: #H2
<BitCount> integer
Range: 1 to 64
*RST: 2
Example: See Example"Marker configuration" on page 87

Manual operation: See "Mode" on page 23

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod:SLOT <Slot>

Sets the repetition rate for the slot clock at the marker outputs.

Parameters:
<Slot> integer
Range: 1to8
*RST: 1
Example: SOURcel :BB:GSM: TRIGger:OUTPut2:MODE SLOT

SOURcel:BB:GSM:TRIGger:OUTPut2:PERiod:SLOT 16

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod[:FRAMe] <Frame>

Sets the repetition rate for the frame clock at the marker outputs.

Parameters:
<Frame> integer
Range: 1 to 67108863
*RST: 1
Example: SOURcel :BB:GSM: TRIGger:OUTPut2:MODE FRAM

SOURcel:BB:GSM:TRIGger:0UTPut2:PERiod:SLOT 16

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for the pulsed marker signal.
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4.7

Power ramping/slot attenuation commands

Parameters:
<Divider> integer
Range: 2 to 1024
*RST: 2
Example: See Example"Marker configuration" on page 87

Manual operation: See "Mode" on page 23

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQuency]?
Queries the pulse frequency of the pulsed marker signal PULSe.

Return values:

<Frequency> float
Example: See Example"Marker configuration" on page 87
Usage: Query only

Manual operation: See "Mode" on page 23

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

Parameters:
<Delay> float
Range: 0 to 16777215
Increment: 1
*RST: 0
Default unit: Samples
Example: See Example"Marker configuration" on page 87

Manual operation: See "Delay" on page 24

Power ramping/slot attenuation commands

[:SOURce<hw>]:BB:GSM:PRAMP:BBONIY[:STATE] .. uueeeeeeriiieeeeeeeetiieeeeeeernieeeeeseesnnseeeeeesnns 89
[:SOURce<hw>]:BB:GSM:PRAMP:FDELAY......cuteiiiiieeeeeeie ettt e e e e e 90
[:SOURce<hw>]:BB:GSM:PRAMP:RDELAY.... ...ttt ettt eee et ee e e e e 90
[:SOURce<hw>]:BB:GSM:PRAMP:ISHAPE. ...ttt e e e 91
[:SOURce<hw>]:BB:GSM:PRAMP:TIME.......cceeeieeeeeeeeeeeieieiieteeeeeae e e e e e e e e e aeaeeeeeeeeeeeeeeenenens 91

[:SOURce<hw>]:BB:GSM:PRAMp:BBONIy[:STATe] <State>

Note: This command is available for instruments with RF output only.
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Power ramping/slot attenuation commands

Selects power ramping in the baseband only or mixed power ramping in the baseband
and the RF section. The "ON" setting is mandatory if, with power ramping active, only
the baseband signal is output (I/Q outputs), or, in case of two-path instruments, if a
baseband signal is applied to two RF paths (RF A and RF B).

Only then can a signal with a defined, predictable level be output.

Parameters:
<State> 1|ON |0 | OFF
*RST: 0
Example: BB:GSM: PRAM:BBON ON

selects power ramping in the baseband only.

Manual operation: See "In Baseband Only" on page 44

[:SOURce<hw>]:BB:GSM:PRAMp:FDELay <FDelay>

The command sets the offset in the Falling edge of the ramp envelope at the end of a
slot. A positive value causes a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:
<FDelay> float
Range: 9 to9
Increment:  0.01
*RST: 0
Default unit: symbol
Example: BB:GSM:PRAM:FDEL -1

Sets an advance of 1 symbol in the falling edge of the envelope
at the end of the slot.

Manual operation: See "Fall Delay" on page 44

[:SOURce<hw>]:BB:GSM:PRAMp:RDELay <RDelay>

The command sets the offset in the Rising edge of the ramp envelope at the start of a
slot. A positive value causes a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:
<RDelay> float
Range: -9 to 9
Increment: 0.01
*RST: 0
Default unit: symbol
Example: BB:GSM:PRAM:RDEL -1

Sets an advance of 1 symbol in the rising edge of the envelope
at the start of the slot.

Manual operation: See "Rise Delay" on page 44
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4.8

Burst editor commands

[:SOURce<hw>]:BB:GSM:PRAMp:SHAPe <Shape>
The command sets the edge shape of the ramp envelope.
Parameters:

<Shape> LINear | COSine

LINear
The transmitted power rises and falls linear fashion.

COSine
The transmitted power rises and falls in the shape of a cosine.

*RST: COSine

Example: BB:GSM:PRAM: SHAP LIN
sets a cosine-shaped rise and fall to the edge.

Manual operation: See "Ramp Function" on page 43

[:SOURce<hw>]:BB:GSM:PRAMp:TIME <Time>

The command sets the edge slope of the ramp envelope. This specifies the number of
symbols over which the switching operation is stretched when the transmitted power is
turned on and off.

Parameters:
<Time> float
Range: 0.3 to 16
Increment: 0.1
*RST: 2
Default unit: symbol
Example: BB:GSM:PRAM:TIME 6

Sets the duration of the switching operation to six symbols.

Manual operation: See "Ramp Time" on page 43

Burst editor commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<StO>TYPE.........ceetiiriirirrerereeree e e 92
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:LEVel... 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

A N 1= g TUE= i O PP PPRPR 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

ST 3= | o P 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

| Y I PP 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNL...........ccerrrrrrrrrrrrrnrnnnnnnannnn 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:

SOURCE]IDATA. ettt et e e rra s 95
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Burst editor commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>][:

SOURCE]:DATAIDLISE. .. tetee e ee et e e e eee e e e e e e e e e e e e ee e e een e e eenneenenns 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:

SOURCE]:DATADLISECATAIOG?. . ettetuuuenaaaeaeaeeeeeaeaeaeeeeeeeeeeeeeeaesnsnsnnnnnaaaaaeaeeeeeaaes 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:

SOURCE]: DATA I PAT TEIMN. . e eetetieeeeeteetteae e e et eetaeeeeeeeertaeeeeserstanteeeseetanaasaeerestanaaaaeens 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:STATE.....ccoeiriiiiiiieeeccrecceeee e, 97

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:SFLag.. 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

RS 1= To U 1S 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>][:

SOURCE] TS CISELECE . cetuuuiiiieiiitieieeieetieee e e e ettt e e e e e ettt ee e e e e eesteaeeeeeessaseeeseeranaaaaes 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:

ST Ot i ST O8] i P 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:

SOURCE]TSCIUSER. ...ttt ettt e e e e e e e e e e bnne e s e e e eeenans 99

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ETSC...99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

ETSCIUSER. ...ttt ettt e e et e e et e e e e et e e e e e e e e e eenans 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

S N (3] I Yo S 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

S N L 1] 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:

010 BTl i) o =T S 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

01 @] BTt o) oW ol L C=Te H N I =Y o PO 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

D10 1LY Y Y Yo F N I =T o 102

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>:TYPE <Type>
Selects the burst (slot) type.

Parameters:

<Type> NORMal | HALF | EDGE | SYNC | FCORrection | DUMMy |
ACCess | ADATa | AEDGe | N16Qam | N32Qam | A16Qam |
A32Qam | HQPSk | H16Qam | H32Qam | HAQPsk | HA16Qam |
HA32Qam | NAFF | NAFH | NAHH | AAQPsk

N16Qam | N32Qam

Normal 16QAM | Normal 32QAM
HQPSk | H16Qam | H32Qam

HSR QPSK | HSR 16QAM | HSR 32QAM

NAFF | NAFH | NAHH
Normal AQPSK Full rate - Full rate | Normal AQPSK Full rate -
Half rate | Normal AQPSK Half rate - Half rate

Axxxxx (All Data)
The types All Data xxx are not defined in the standard.

*RST: NORMal

User Manual 1179.2048.02 — 05 92



R&S®SMM-K40/-K41 Remote-control commands

Burst editor commands

Example: BB:GSM:SLOT:TYPE DUMM
Selects dummy burst type for slot 1.

Options: Higher symbol rate mode, higher order modulation schemes
(16QAM and 32QAM) and AQPSK require R&S SMM-K41.

Manual operation: See "Burst Type" on page 47

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:LEVel <Level>

The command defines the power control level of the selected slot.

Parameters:
<Level> OFF | ATT | FULL

OFF
The slot is inactive.

ATT
The power is reduced by the amount defined
using :BB:GSM:SLOT :ATT.

FULL
Full power as specified by the level setting.

*RST: Slot 0: FULL; Slots 1...7: OFF

Example: BB:GSM:SLOT2:LEV FULL
selects power control level Full Power for slot 2.

Manual operation: See "Slot Level" on page 51

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ATTenuation <Attenuation>

The command selects one of seven possible values for the level attenuation. This
value defines by how much the power of the selected slot with power control

level :BB:GSM:SLOT:LEV ATT is reduced in relation to the normal output power
(attribute . .. :LEVEL FULL). The seven possible values are set using the com-
mand : SOURce:BB:GSM: SATTenuation<n>.

Parameters:
<Attenuation> A1|A2| A3 | A4 | A5 | A6 | A7
Example: BB:GSM:MODE SING

Selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT

Sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB

Sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT Al
Sets the level attenuation for slot 0 dB to 12 dB.

Manual operation: See "Slot Attenuation" on page 51
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Burst editor commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SCPIRatio <SCPIRatio>

The command selects one of eight possible values for the SCPIR. The eight possible
values are set using the command [ : SOURce<hw>] :BB:GSM: AQPSk: SCPIR<ch0>.

Parameters:

<SCPIRatio> SCPIR7 | SCPIR6 | SCPIR5 | SCPIR4 | SCPIR3 | SCPIR2 |
SCPIR1 | SCPIRO
*RST: SCPIRO

Example: BB:GSM:AQPS:SCPIR5 -10

BB:GSM:SLOT:SUBC2:SCPIR SCPIRS

Manual operation: See "SCPIR" on page 50

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FILTer:TYPE <Type>

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter is used for the
selected burst type and modulation.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM: SRAT:MODE HSR

Selects higher symbol rate mode.
BB:GSM:FRAMI : SLOT1:TYPE H16Q

Selects HSR 16QAM burst type for slot 1.
BB:GSM:FRAM1:SLOT1:FILT:TYPE EWPS

Selects Wide Pulse Shape filter for slot 1.
Options: R&S SMM-K41

Manual operation: See "Filter" on page 39
See "Filter" on page 40
See "Filter" on page 40
See "Filter" on page 51

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNt <Count>

Sets the number of slots combined in a multislot. Since multislot involves connecting
multiple slots to a single user channel, this configuration is possible for Normal (Full
Rate) bursts Normal (8PSK / EDGE) burst (SOUR:BB:GSM: FRAM: SLOT : TYPE
NORM | EDGE) and EDGE Evolution bursts.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe con-
figuration, this setting applies to the slots in all frames.
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Parameters:
<Count>

Example:

Manual operation:

Burst editor commands

integer

Range: 1to7
*RST: 1

BB:GSM:MODE SING
Selects GSM mode Frame (Single).
BB:GSM:SLOTO0:TYPE NORM

Selects the NORMal burst type for slot 0.
SLOT1 ... SLOT7

Selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULTO:COUN 8

Defines a multislot from all eight slots.
BB:GSM:MULTO: STAT ON

Switches the multislot configuration on.

See "Number of Slots" on page 52

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA <Data>

The command defines the data source for the DATA fields in the burst. This command
is valid only when burst types that contain data fields are selected. If a burst contains
multiple DATA fields, these are treated as a continuous field. For instance, data such
as a pseudo-random sequence is continued without interruption from one DATA field to

the next.

In "GSM Mode Unframed", this command defines the data source for the unframed sig-
nal. The suffix in : SLOT has to be setto 0 (BB:GSM: SLOTO : DATA).

Parameters:
<Data>
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ALLO | ALL1 | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |
PN21 | PN23 | DLISt

PNxx

The pseudo-random sequence generator is used as the data
source. There is a choice of different lengths of random
sequence.

DLISt

A data list is used. The data list is selected with the aid of com-
mand SOURce :BB:GSM: SLOT : DATA: DLISt.

ALLO | ALL1
Internal O or 1 data is used.

PATTern
Internal data is used. The bit pattern for the data is defined with
the aid of command : SOURce:BB:GSM: SLOT : DATA: PATTern.

*RST: PN9
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Burst editor commands

Example: BB:GSM:SLOT2:TYPE NORM
Selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:DATA PN15
Selects internal PRBS data with period length 21%-1 as the data
source for the DATA fields in the burst. The pseudo-random
sequence is continued without interruption from one DATA field
to the next.

Manual operation: See "Data" on page 26
See "Data for Data Field of Slot" on page 53

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt <DList>

The command selects a data list. This command is only valid for bursts with DATA
fields. This data list is only used if it is set as the data source with the aid of com-
mand :BB:GSM:SLOT:DATA DLIS.

Parameters:
<DList> string
Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.

BB:GSM:SLOT2:DATA DLIS

selects internal data lists as the data source for DATA fields.
BB:GSM:SLOT2:DATA:DLIS 'test'

selects the test data list. The data list is continued without inter-
ruption from one DATA field to the next.

Manual operation: See "Data" on page 26
See "Data for Data Field of Slot" on page 53

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt:CATalog?

This command reads out the data list files in the default directory. The default directory
is set using command MMEM: CDIRectory. Only files with the file extension *.dm_ iqd
are listed.

Return values:
<Catalog> string

Example: MMEM:CDIR '/var/user/temp/dlist gsm'

Sets the default directory to /var/user/temp/dlist_gsm.
BB:GSM:SLOT2:DATA:DLIS:CAT?

Queries the available data lists in /var/user/temp/dlist_gsm.
Response: 'test 01','test 02'

Data lists test 01 and test_ 02 are available in /var/user/
temp/dlist_gsm.

Usage: Query only

Manual operation: See "Data for Data Field of Slot" on page 53
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Burst editor commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:PATTern <Pattern>, <BitCount>

Sets the data pattern for the internal data when PATTern is selected as the data
source. The length depends on the length of the data fields in the selected burst type.

Parameters:
<Pattern> numeric
*RST: #HO
<BitCount> integer
Range: 1 to 64
*RST: 1
Example: BB:GSM:SLOT2:TYPE ACC

selects the Access burst type for slot 2. This burst type contains
a 36-bit data field.

BB:GSM:SLOT2:DATA PATT

selects Pattern as the data source.
BB:GSM:SLOT2:DATA: PATT #H801FA, 20

generates the data for the data field in the burst.

Manual operation: See "Data" on page 26
See "Data for Data Field of Slot" on page 53

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:STATe <State>
Switches the multislot configuration on.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe config-
uration, this setting applies to the slots in all frames.

Parameters:

<State> 1|ON |0 | OFF
*RST: 0

Example: BB:GSM:MODE DOUB

Selects GSM mode Frame (Double).
BB:GSM:SLOTO: TYPE NORM

Selects the NORMal burst type for slot 0.
SLOT1 ... SLOT7

Selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULTO0:COUN 8

Defines a multislot from all eight slots.
BB:GSM:MULTO: STAT ON

Switches the multislot configuration on.

Manual operation: See "Multislot Configuration" on page 51
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Burst editor commands

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag <SFlag>

The command sets the Stealing Flag state (only for Normal
burst :BB:GSM:SLOT: TYPE NORM).

Parameters:
<SFlag> 011
*RST: 0
Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1
sets Stealing Flags for slot 2 to the value 1.

Manual operation: See "Stealing Flag" on page 54

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag:USE <Use>

The command enables or disables the use of Stealing Flags. If not used, the Stealing
Flags bits are allocated to the DATA fields (only for Normal
burst :BB:GSM: SLOT: TYPE NORM).

Parameters:
<Use> 1|ON |0 | OFF
*RST: ON
Example: BB:GSM:SLOT2:TYPE NORM

selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1

sets Stealing Flags for slot 2 to the value 1.
BB:GSM:SLOT2:SFL:USE ON

enables the use of Stealing Flags for slot 2.

Manual operation: See "Use Stealing Flag" on page 54

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SELect <Select>

The command selects the training sequence code. The values specified in GSM 5.02
are TO...T7. When USER is selected, the value specified with the aid of

the ... :TSC:USER command described next is used.

Parameters:

<Select> TO|T1|T2|T3|T4|T5|T6|T7 | USER
*RST: TO
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Burst editor commands

Example: BB:GSM:MODE SING

selects Single Frame mode.
BB:GSM:SLOT2:TYPE NORM

selects Normal burst for slot 2.
BB:GSM:SLOT2:TSC:SEL T3

selects training sequence code T3 for slot 2.

Manual operation: See "TSC" on page 54

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SET <Set>

Sets the TSC set for the corresponding GMSK normal burst or VAMOS subchannel,
user and slot.

Parameters:
<Set> SET1 | SET2
*RST: SET1
Example: BB:GSM:SLOT2:SUBC2:USER2:TSC:SET SET2

Manual operation: See "TSC Set" on page 54

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:USER <User>

The command specifies the user-defined training sequence code. This code is used if
the USER parameter is set with the aid of the [ : SOURce<hw>] :BB:GSM] :
FRAMe<di>] :SLOT<st0>[:SUBChannel<us>] [ :USER<ch>] [ : SOURce] : TSC:
SELect command. The length is 26 bits for :BB:GSM: SLOT: TYPE NORMal and 78
bits for :BB:GSM: SLOT: TYPE EDGE.

Parameters:

<User> integer
Range: #B0,1 to #B111,1...26/78 bits
*RST: #H0970897

Example: BB:GSM:SLOT3:TSC:USER #H3FFFFFF

enters the user-defined training sequence for slot 3.

Manual operation: See "TSC Pattern" on page 54

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC <Etsc>

The command selects an extended training sequence for the Synchronization burst.
There is a choice of three predefined sequences STANdard | CTS | COMPact and,
if defined, a USER sequence (only for selection of burst type :BB:GSM: SLOT: TYPE
SYNC).

Parameters:
<Etsc> STANdard | CTS | COMPact | USER
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Burst editor commands

Example: BB:GSM:SLOT:TYPE SYNC

Selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC CTS
Selects the extended training sequence CTS.

Manual operation: See "Ext Training Seq ETSC" on page 55

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC:USER <User>

(only for selection of burst type :BB:GSM: SLOT: TYPE SYNC)

The command selects an extended training sequence for the Synchronization burst

USER sequence.

Parameters:

<User> integer

Example: BB:GSM:SLOT:TYPE SYNC

Selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC USER

Selects the extended training sequence User.
BB:GSM:SLOT:ETSC:USER #H5ab5ababababababa, 64

Sets the ETSC.
Manual operation: See " ETSC Pattern" on page 55

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:SELect <Select>

The command selects a training sequence (SYNC sequence) for the Access burst
(only for burst type selection :BB:GSM: SLOT: TYPE ACC).

Parameters:
<Select> TO|T1| T2 | USER
*RST: TO
Example: BB:GSM:SLOT1:TYPE ACC

selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL T1

selects Sync sequence T1.

Manual operation: See "Training Sequence Sync" on page 55

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:USER <User>

The command outputs the bit pattern of the User Sync sequence for the Access burst.
The length is 64 bits. Superfluous bits are truncated on input. Missing bits are filled
with 0. The command is valid only for selection :BB:GSM: SLOT: SYNC: SEL USER and
for burst type selection :BB: GSM: SLOT: TYPE ACC.
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Parameters:
<User> integer
Range: #B0,1 to #B111...,41
*RST: Bit pattern from TO
Example: BB:GSM:SLOT1:TYPE ACC

selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL USER

selects the User Sync sequence.
BB:GSM:SLOT1:SYNC:USER #HFFFFFFFFFFO, 41

enters the User Sync sequence.

Manual operation: See "Sync Pattern" on page 55

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed <Fixed>

The command selects the content of the FIXED field for the Frequency Correction
burst. There is a choice of two predefined sequences STANdard and COMPact and, if
defined, a USER sequence (only for burst type selection :BB: GSM: SLOT: TYPE

FCORrection).

Parameters:

<Fixed> STANdard | COMPact | USER
*RST: STANdard

Example: BB:GSM:SLOT:TYPE FCOR

selects Frequency Correction burst for slot 1.
BB:GSM:SLOT:FCOR:FIX COMP
selects content type COMPact for the Fixed field.

Manual operation: See "Fixed" on page 55

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed:PATTern <Pattern>, <BitCount>

Sets the bit pattern of the FIXED field for the Frequency Correction burst. The length is
142 bits. Superfluous bits are truncated on input. Missing bits are filled with 0. The
command is valid only for the selection :BB:GSM: SLOT: FCOR:FIX USER and for
burst type selection :BB:GSM: SLOT: TYPE FCOR.

Parameters:
<Pattern> numeric

*RST: #H000000000000000000000000000000000000
<BitCount> integer

Range: 142 to 142

*RST: 142
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Slot marker definition commands

Example: BB:GSM:SLOT:TYPE FCOR
selects Synchronization burst for slot 1.
BB:GSM:SLOT:FCOR:FIX USER
selects content type USER for the Fixed field.
BB:GSM:SLOT:FCOR:FIX:PATT #BO, 142
enters the content of the field.

Manual operation: See "Fixed Pattern" on page 56

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:DUMMy:MIXed:PATTern?

This command outputs the bit pattern of the Mixed field of the Dummy burst. The con-
tents of the Mixed field is fixed and specified by the standard, the length is 142 bits.

Return values:
<Pattern> 142 bits

Example: BB:GSM:SLOT1:TYPE DUMM
selects Dummy burst for slot 1.
BB:GSM:SLOT1:DUMM:MIX:PATT?
outputs the bit pattern of the Mixed field.
Response:

Usage: Query only

Manual operation: See "Mixed" on page 56
4.9 Slot marker definition commands
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:TRIGger:

OUTPut:TAG?

The command queries the content of the specified marker in the selected file.

Suffix:

<di> <di>

<st0> oy .. 7

<ch> <di>

Parameters:

<Tag> string

Example: BB:GSM:FRAM: SLOTO0:UER1 : TRIG:OUTP: TAG? "MARKER
LIST 1"
queries the content of the marker list 1.
Response: 0:1;59:0;64:1,70:0

Usage: Query only

Manual operation: See "Configure Control Signal" on page 58
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List of commands

[:SOURce<hw>]:BB:GSM:AQPSK:ANGLESCNOS........iiiiiiiiiiieit e 78
[:SOURce<hw>]:BB:GSM:AQPSK:FORMAL?.......cociiiiiiiiiiiieiee ettt 75
[:SOURce<hw>]:BB:GSM:AQPSK:SCPIRSCRO> ..ottt 78
[:SOURCe<hw>]:BB:GSM:CLOCK:SOURCE. ......ccuieiiiiieiiiiiieie ittt ettt eeanean 81
[:SOURce<hw>]:BB:GSM:EDGE:FORMAL?.........ooiiiiiiiiie ittt 75
[:SOURce<hw>]:BB:GSM:FILTENAQPSKITYPE?. ...ttt 79
[:SOURce<hw>]:BB:GSM:FILTErEDGETYPE? ... .ottt ettt 80
[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE........coo et 80
[:SOURce<hw>]:BB:GSM:FILTer:H32Qami:TYPE........coi ettt 81
[:SOURce<hw>]:BB:GSM:FILTer:HQPSk:TYPE
[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?......coiiiiiiiieie e 80
[:SOURce<hw>]:BB:GSM:FILTErN32Qami:TYPE?......coiiiiiiieeie ettt 80
[:SOURce<hw>]:BB:GSM:FILTErPARAMELE......c..oiiiiiiiiiie et e 79
[:SOURCE<hW>]:BB:GSM:FILTERTYPE?. ... ittt 79
[:SOURCE<hW>]:BBIGSMIFLENGN. ...ttt e et 63
[:SOURCE<hW>]:BBIGSMIFONE. ...ttt ettt ettt et et e e eaeeneeaneas 64
[:SOURce<hw>]:BB:GSM:FORMat...........ccceereernnnns . 74
[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPELItIONS........c.eeiiiiieiciiieccee e 64
[:SOURce<hw>]:BB:GSM:FRAME<di>:ULISt:CATAIOF?.......ceiuiiieeiiiiieieeieee ettt 70
[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELELE........ccoiiiiiiiiieee e 70
[:SOURce<hw>]:BB:GSM:FRAME<Ai>:ULISt:ILOAD........c.eeiiitiie et e 71
[:SOURce<hw>]:BB:GSM:FRAME<di>:ULISt:STORE. ......eiiiiiiiiiiieiieie e 71
[:SOURCe<hW>]:BB:GSM:FSKIDEVIGtON. .....cuiiiiiiiiiiiieeie ettt 75
[:SOURce<hw>]:BB:GSM:H16Qam:FORMat?..... e 16
[:SOURce<hw>]:BB:GSM:H32Qam:FORMAL?.......cc.oiiiiiiiieiee ettt 76
[:SOURce<hw>]:BB:GSM:HQPSK:FORMAL?.......c..oiiiiiiiiiieie et 77
[:SOURCE<hW>]:BB:GSM:ISLENGLN........eiiiiiiie ittt ettt e et be et e et eebeesneeenee 64
[:SOURCE<hW>]:BB:GSMIMODE........c..oiiiiiiiii ittt te e 65
[:SOURce<hw>]:BB:GSM:N16QamM:FORMAL?........ccouiiiiiiiieit et 77
[:SOURce<hw>]:BB:GSM:N32Qam:FORMAL?........cciuiiiiiiiieiie ettt ettt anees 77
[:SOURce<hw>]:BB:GSM:PRAMP:BBONIY[:STATE]......ccueeuiiieeiieiie ettt 89
[:SOURCce<hw>]:BB:GSM:PRAMP:IFDELAY.........tiiiiiiiiiiiiaiieeit ettt ettt 90
[:SOURce<hw>]:BB:GSM:PRAMPIRDELAY.........cciiiiiieiiiaiie ittt ettt ebeesbe e e b e sneeennee e 90
[:SOURCe<hw>]:BB:GSM:PRAMPISHAPE. ......cueiiiitiiiieeee ettt 91
[:SOURce<hw>]:BB:GSM:PRAMp:TIME .
[:SOURCEShW>]:BB:GSIMIPRESEL.......cccciiiiiiiiee ettt e e e et e e e eaee e e aaeaeesaeaeeans
[:SOURce<hw>]:BB:GSM:SATTENUAtIONSKCR> . ....o.iiiiiiii e 66
[:SOURce<hw>]:BB:GSM:SETTING:CATAIOG?........coieiiiiieitieiie ettt 66
[:SOURCce<hw>]:BB:GSM:SETTING:DELELE. .....ccuiiiiiiiiieiie ettt 66
[:SOURCce<hw>]:BB:GSM:SETTING:LOAD ... ..ottt ettt ne e aeeas 67
[:SOURCce<hw>]:BB:GSM:SETTING:STORE. .......utiiiiiiiiiiiiiiii ettt sttt 67
[:SOURce<hw>]:BB:GSM:SLENgth

[:SOURCE<hW>]:BB:GSMISIMODE.........cotiiiiiiiiieie ettt ettt ettt et e b ebe e e
[:SOURCEShWS]:BBIGSIMISRATE. ...ttt ettt ettt et et nae e et e et e e b e e saeeaneeas
[:SOURCe<hw>]:BB:GSM:SRATEIMODE.........ccoiiiiiiiie ettt eae e e e e e e e e baeeannes 68
[:SOURCESNWS]:BBIGSMISTATE. ...ttt ettt ea e bt e bt se e bt ene et e ene et e nneeneesneenee e 69
[:SOURce<hw>]:BB:GSM:TRIGGErARM:EXECULE. .......oiiitiiiiiiiii ittt 83
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[:SOURce<hw>]:BB:GSM:TRIGGEINEXECULE. .......coiiiiiiiiiitiiiii ettt
[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut...
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:DELAY.......cccoiiiiiiiiiiiieiiciiee e
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>:MODE............ccciiiiiiiiiieiie e 87
[:SOURce<hw>]:BB:GSM:TRIGGer:OUTPUt<Ch>:OFFTIME.....ccciioiiiiiiierieciieieeee et 87
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<Ch>IONTIME.......ciiiiiiiiiiiiie ittt 87
[:SOURce<hw>]:BB:GSM:TRIGGer:OUTPUt<Ch>:PATTEIMN.......ccuiiiiiiiiieiieeitee e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPUt<ch>:PERIOA:SLOT ......ccciiiiiiiiiiiieicrieeeesieee e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERIOA[:FRAME].........corriiiiiiriiiiieieeee e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPuUt<ch>:PULSE:DIVIEr.........cccciiiiiiiiiiiiiiiiieese e 88
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQUENCY]?........cceriiiiiiiiinienieneeeieeee e 89
[:SOURce<hw>]:BB:GSM:TRIGGEIRMODE?.......ccuiiiiiiiiiiiiie ittt 83
[:SOURce<hw>]:BB:GSM:TRIGger:SLENgth...
[:SOURCce<hw>]:BB:GSM:TRIGGENSLUNIL......ccueiiiitiiieitieiesii ettt
[:SOURce<hw>]:BB:GSM:TRIGGEINSOURGCE. .....ccueiiiiiiiiiiiieiite ettt
[:SOURce<hw>]:BB:GSM:TRIGGENTIME:DATE. ...ttt 85
[:SOURce<hw>]:BB:GSM:TRIGGENTIME:TIME........oiiiiiiiiiie ittt 86
[:SOURce<hw>]:BB:GSM:TRIGGENTIME[STATE]......ceitiiiieiiietieiee ettt 86
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernall:DELAY..........ccccouiiiiiiiiiiie it 85
[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernall:INHIDIt............ccooiriiiiii e 85
[:SOURce<hw>]:BB:GSM:WAVEfOrM:CREGLE.........coiiiiiiiiiieie e 69
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<stO>:COUNL............ccccuiriiiiieiiiie e 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTISIOt<St0>:STATE......cc.eeiieriiieiiniieie e 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATaIOg?........cciuiiiiiiieeiee it 71
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDEfINEd:LOAD.........cccuiieiiieeeee et
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<StO>:TYPE........cciiiiieiiiietieee e

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:AT Tenuation
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:DUMMy:

IMIIXEAIPATTEIN? ... ettt ettt ettt ettt e b e e e st e e eh e e e et e es e e e beeeaee e st e enbeeaseeenseeeaeaenseeeseeeabeeaneaanns 102
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ETSC..............cc....... 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ETSC:USER.......... 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

[T ¢=Te1 o] H ol 1Yo SRS 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:

FCORIECHON:FIXEA:IPATTEIN. ...ttt ettt et e e e et e e e ste e e e snteeeaeneeaeanneeeanes 101
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:FILTer:TYPE............ 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:LEVel....................... 93
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:PREDefined:

(07N -1 oo SO PP UPRRUPN 72
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:PREDefined:LOAD.. 72
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:SCPIRatio................ 94
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:SFLag.............cc....... 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:SFLag:USE.............. 98
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:SYNC:SELect........ 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:SYNC:USER.......... 100
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>]:ULISt:CATalog?....... 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ULISt:DELete........... 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ULISt:LOAD............. 73
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>]:ULISt:STORe........... 74
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:SOURce]:DATA...... 95
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:SOURCce]:

DATAIDLIST. ..ttt ettt ettt et oo e e e bt e eh e e e et e en et e teeen b e e eaeeeateeenbeebeeeneeeeneeenneeneean 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>][:SOURce]:

(DN N B S 07N -1 o ISP P PR TROPPPPON 96
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>][:SOURce]:

[N I N =Y o USSR 97
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:SOURCce]:

LS O3S T = =Y PO TOURU PR PTURPTOURINE 98

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][: USER<ch>][:SOURce]: TSC:SET 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:USER<ch>][:SOURCce]:

TSCIUSER . ..ottt ettt ettt et et e e st s e e ae e saeese et e e ae et e e he et e b e et e ebeen b e eteenteeaeeneeeaeeneeeaeereen 99
[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]: TRIGger:OUTPut: TAG?.........cccvvrvureene. 102
[:SOURce<hw>]:BB:GSM[:TRIGger]:SEQuence
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